Welcome to NX

June 2019

Dear Customer:

We are proud to introduce the latest release of NX, which brings significant new and enhanced functionality in all areas of the product to help you work more productively in a collaborative managed environment.

This release builds on the continuous release process that is designed to make it easier for you to stay current with the latest releases of NX, giving you faster access to the latest functionality, and performance and quality improvements, to ensure that you gain the most from your investments.

Design

To optimize product development, we have invested in all aspects of modeling, including:

- Traditional and Convergent Modeling™ software
- Core functionality, such as visualization and user interaction
- Mesh modeling capabilities that give you new ways to work with facet-based geometry, reuse geometry from scanners and simulation, and map 3D textures to your models based on 2D images
- PCB integration and wire harness creation to support more advanced electromechanical design workflows

Manufacturing

New and enhanced CAM capabilities in NX allow you to use advanced manufacturing methods, cutting tools, and technologies, boosting your productivity.

Automated NC programming, enhanced machining process visualization, and G-code-driven robotic simulation enable efficient programming while ensuring error-free production. High-speed machining, combined with a new generation of barrel-shaped tools, enables significantly shorter machining times. Machining Line Planner’s improvements let you effectively program individual or combined parts while using the in-process workpiece (IPW) to generate complete shop documentation, including associative drawings.

Simcenter 3D

We have strengthened the core of Simcenter 3D to help you drive innovation while reducing the effort, cost, and time needed to predict product performance.

To support faster CAE processes, multidiscipline integration, openness and scalability, and ties to the digital thread, the following enhancements are added:
• New solutions for both high- and low-frequency electromagnetics

• The ability to instantly compute and update flexible pipe configurations after a design change

• Support for the immersed boundary method to accelerate CFD model build time

• Increased openness and solver support for ANSYS and Abaqus, to allow leveraging of structural vibrations and modes for acoustics and durability

• Extended scalability for Simcenter 3D Specialist Durability to support parallel computing, so you can solve large analysis problems in hours instead of days

• Streamlined interface between Simcenter 3D and Simcenter Testlab that facilitates tighter collaboration between simulation analysts and test engineers

We are confident that the new capabilities in this release will allow you to work more productively than ever before, and to achieve your product requirements while staying at the forefront of industry trends.

For more information about this release, see the What’s New Guide included with the NX help.

Sincerely,

Your NX team
## Contents

**Welcome to NX** 3  

**System Information**  
Customer support 1-1  
Platforms 1-1  
- NX central runtime directory 1-1  
- System requirements guidelines 1-3  
- Operating system requirements 1-6  
- Supported hardware and graphics 1-11  
- NX Open programs on Linux 1-12  
- Initializing the JVM 1-13  
- NX variables in the ugii_env.dat file 1-15  

**Browser requirements** 1-17  
- Browser and plug-in requirements 1-17  
- Browser caveats 1-19  

**Licensing Caveats** 1-20  
- General licensing caveats 1-20  
- Licensing caveats for Windows 1-21  
- Licensing caveats for Linux 1-22  

**Product compatibility - supported version combinations** 1-23  

**NX compatibility with Spreadsheet** 1-25  

**NX applications unsupported on specific platforms** 1-26  

**Support for touch enabled devices** 1-27  

**Teamcenter Integration for NX**  
Product Notes 2-1  
Caveats 2-2  

**Fundamentals**  
Product Notes 3-1  
Caveats 3-3  

**Customer Defaults**  
Customer defaults 4-1  

**Design (CAD)**  
Assemblies 5-1  
Caveats 5-1  
Drafting 5-3  
- Product Notes 5-3  
- Caveats 5-4
## Product Notes

### Layout
- Product Notes
- 5-5

### Product and Manufacturing Information (PMI)
- Product Notes
- 5-5

### Ship Structure
- Caveats
- 5-6

### Sheet Metal
- Caveats
- 5-6

### Human Modeling
- Product Notes
- 5-8
- Documentation Notes
- 5-9

### PCB Exchange
- Caveats
- 5-9

## Manufacturing (CAM)

### Manufacturing Product Notes
- Manufacturing Product Notes
- 6-1
- CAM Early Validation Program
- 6-2
- Tool path and template changes
- 6-3
- General changes
- 6-6
- Milling
- 6-7
- Integrated Simulation and Verification (ISV)
- 6-8
- Feature-based Machining (FBM)
- 6-9
- Post
- 6-10
- Machining Line Planner
- 6-11
- Manufacturing critical maintenance and retirement notices
- 6-12
- Manufacturing documentation notes
- 6-16

### Manufacturing caveats
- General caveats
- 6-16
- Milling caveats
- 6-18
- Turning caveats
- 6-19
- Hole machining caveats
- 6-20
- ISV caveats
- 6-21
- Post Configurator
- 6-24
- Feature based machining caveats
- 6-25

### Fixture Planner
- Product Notes
- 6-25
- Documentation Notes
- 6-28
- Caveats
- 6-29

### Line Designer
- Product Notes
- 6-29
- Documentation Notes
- 6-32
- Caveats
- 6-33

### Additive Manufacturing
- Product Notes
- 6-34
- Caveats
- 6-38
- Documentation Notes
- 6-39

### Additive Manufacturing Process Simulation
- 6-39
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caveats</td>
<td>6-39</td>
</tr>
<tr>
<td><strong>CMM Inspection Programming</strong></td>
<td>6-39</td>
</tr>
<tr>
<td>CMM release notes</td>
<td>6-39</td>
</tr>
<tr>
<td>Caveats</td>
<td>6-40</td>
</tr>
<tr>
<td><strong>Simcenter 3D</strong></td>
<td>7-1</td>
</tr>
<tr>
<td>Simcenter 3D supported platforms</td>
<td>7-1</td>
</tr>
<tr>
<td>Pre/Post caveats</td>
<td>7-2</td>
</tr>
<tr>
<td>Motion caveats</td>
<td>7-12</td>
</tr>
<tr>
<td>Simcenter Nastran 2019.2 caveats</td>
<td>7-15</td>
</tr>
<tr>
<td>Finding software field bulletins (SFBs)</td>
<td>7-19</td>
</tr>
<tr>
<td><strong>Knowledge Fusion and DesignLogic functions</strong></td>
<td>8-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td></td>
</tr>
<tr>
<td><strong>Validation</strong></td>
<td>9-1</td>
</tr>
<tr>
<td>Check-Mate and Requirements Validation</td>
<td>9-1</td>
</tr>
<tr>
<td>Caveats</td>
<td>9-1</td>
</tr>
<tr>
<td><strong>Tooling Design</strong></td>
<td>10-1</td>
</tr>
<tr>
<td>Tooling Design documentation notes</td>
<td>10-1</td>
</tr>
<tr>
<td>Press Die Checker</td>
<td>10-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>10-1</td>
</tr>
<tr>
<td>OmniCAD</td>
<td>10-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>10-1</td>
</tr>
<tr>
<td><strong>Mold Wizard</strong></td>
<td>10-1</td>
</tr>
<tr>
<td>Optimized settings for MW Part Family Library</td>
<td>10-2</td>
</tr>
<tr>
<td><strong>Progressive Die Wizard</strong></td>
<td>10-2</td>
</tr>
<tr>
<td>Optimized settings for PDW Part Family Library</td>
<td>10-2</td>
</tr>
<tr>
<td><strong>Data translation</strong></td>
<td>11-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td></td>
</tr>
<tr>
<td>Caveats</td>
<td>11-2</td>
</tr>
<tr>
<td><strong>Mechatronics Concept Designer</strong></td>
<td>12-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td></td>
</tr>
<tr>
<td><strong>Automation Designer</strong></td>
<td>13-1</td>
</tr>
<tr>
<td>Requirements for running Automation Designer NX 1847</td>
<td>13-1</td>
</tr>
<tr>
<td>Caveats</td>
<td>13-2</td>
</tr>
<tr>
<td><strong>Programming Tools</strong></td>
<td>14-1</td>
</tr>
<tr>
<td>Open C</td>
<td></td>
</tr>
<tr>
<td>New Open C routines</td>
<td>14-1</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Obsoleted Open C routines</td>
<td>14-2</td>
</tr>
<tr>
<td>Deleted Open C routines</td>
<td>14-4</td>
</tr>
<tr>
<td><strong>NX Open</strong></td>
<td>14-4</td>
</tr>
<tr>
<td>- NX Open differences between releases</td>
<td>14-4</td>
</tr>
<tr>
<td><strong>Release upgrades</strong></td>
<td>14-5</td>
</tr>
<tr>
<td><strong>Product Notes</strong></td>
<td>14-8</td>
</tr>
</tbody>
</table>
1. System Information

Customer support

Customers covered by valid maintenance agreements are eligible to receive telephone and web support from the Global Technical Access Center (GTAC) on issues regarding any current or past release. If you are a customer of one of our partners or resellers, you should contact them first to determine who is your first line support provider. If your first line of support is provided by one of our partners, they will contact us on your behalf if needed to respond to your issue.

To report serious problems against supported releases, please contact your local GTAC support center. You can find your local support center, contact phone numbers and additional information on GTAC support and available services by visiting our GTAC page at http://www.siemens.com/gtac

We will always assist our customers to the best of our ability.

Platforms

NX central runtime directory

Central runtime directory concept

To help you find executables and libraries, and distinguish them from configuration files more easily, a central runtime directory that contains DLLs (or so's, or dylib's), executables, and JAR files is now used. The central runtime directory will be updated as NX supports more and different applications.

Scripts that are used to wrap executables have not been moved and they are still in their original kit locations with the configuration files.

NXBIN directory

The central runtime directory, NXBIN, is created on all platforms at the UGII_BASE_DIR\nxbin location during the NX installation. Depending on what was selected to be installed, libraries and executables from different kits are consolidated into the central runtime directory during the install process.

The new NX runtime directory does not contain all binaries and executables. Only the most frequently used files from the following directories have been moved:

- UGII
- UGMANAGER
- STEP203UG
• STEP214UG
• PVTRANS
• MACH

Other files will also be moved over time. However, some applications, such as NX Nastran, will not be moved.

While NXBIN does not contain all of the executables and DLL's, it does contain a large quantity and is a prime location to search for an executable or library.

**UGII_ROOT_DIR obsoleted**

UGII_ROOT_DIR has historically been used to find the following in the UGII directory:

- Libraries and executables
- Configuration files

With the creation of the central runtime directory, there are two different locations for these files (nxbin and ugii), so the concept of UGII_ROOT_DIR is obsoleted. Use the UGII_BASE_DIR variable instead when you write custom application code and scripts.

While the NX install no longer sets UGII_ROOT_DIR, the definition on the system will remain to support earlier releases. If your code or scripts rely on UGII_ROOT_DIR, modify them to ensure they still work in this release.

**Teamcenter code and scripts**

To provide backward compatibility with released versions of Teamcenter, all executables called directly by Teamcenter code or scripts are wrapped.

The wrapper executables just correct the settings of the UGII_BASE_DIR, PATH, and LD_LIBRARY_PATH variables that are set by the Teamcenter scripts and code, and then start up the real executable from the NXBIN directory. This enables support for the new runtime concept, while allowing NX to run with existing versions of Teamcenter.

These new wrapper executables must remain in the ugii and ugmanager directories since that is where Teamcenter code expects to find them. Two processes are shown for executables invoked from the ugii and ugmanager directories.

Executables are still in the UGII, UGMANAGER, STEP203UG, STEP214UG, and PVTRANS kits.

Teamcenter code migration to the new central runtime directory structure is scheduled in a future Teamcenter release.
System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably memory, can vary dramatically from user to user. The following are general guidelines that you should consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the performance is," but this only applies when comparing like architectures. For example, it is difficult to arrive at performance expectations for an Intel processor when compared to an AMD processor just by looking at their respective processor speeds. There is also a general trend today to de-emphasize processor speeds and move to multi-core processors, which actually can have lower processor speeds.

NX takes advantage of modern processors, and if a processor does not have the required functionality, you will see the following error message and NX will not run on the installed CPU:

This processor is too old and not supported anymore

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of NX capabilities have some threading. In general, it is not possible to quote a figure for the general performance improvement achieved by using SMP, since this improvement depends on the nature of the operations you are performing. You need to evaluate your actual performance gains using your own models. Functional areas that are SMP enabled in Parasolid include:

- Validity checking
- Boolean operations
- Wireframe
- Rendering
- Hidden line rendering
- Closest approach
- Faceting
- Mass properties
SMP is enabled by default with the variable `UGII_SMP_ENABLE`, which is located in the `ugii_env_ug.dat` file.

**Multi-Core**

Multi-core processors are similar to SMP because there are two or more actual processor cores but they are delivered in single processor packages. Siemens PLM Software has found that multi-core performance characteristics are similar to SMP. The one advantage of multi-core processors over SMP is that this technology has proliferated much faster than SMP and is now common in workstations, servers, and laptops.

Multi-core technology is complex and, depending on the configuration, can actually have a negative impact on performance. This is due to the potential conflict of multiple cores sharing system resources, such as cache, memory, and bus bandwidth, as well the need for the system to manage and control an increasing number of cores. Increasing the number of cores does not always translate into better performance. Although additional cores can improve NX performance, processor speed is still a vital measurement of NX performance.

Many systems enable you to turn off cores via the bios, which can enable you to compare performance with a different number of cores that are active. Some users may find that turning off some cores will actually improve performance. One micro-architecture (Intel) even does this automatically, shutting down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the limitations of older multi-core technologies. New subsystems better integrate memory and other peripherals directly to the processors, resulting in major performance improvements. Buses are being eliminated, cores are better managed, and channel speeds continue to improve.

In summary:

- Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a slight overhead.
- Turn SMP on if you have a multi-core system.
- Never assume that by simply adding more cores you will see better performance. Always test first.

**Memory**

The minimum recommended amount of memory to run native NX is 8GB. If you are running NX with Teamcenter (Teamcenter Integration for NX), the minimum recommended is 12 GB. However, because NX is capable of handling large assemblies and very complex parts, many of our customers use workstations with 32GB of RAM, and some even use 64GB, 96GB, or more.

For the optimum user experience and application performance, we recommend that you install as much RAM as can be installed in the client workstation that is running NX.
As a guideline, so that you get the best possible performance when using NX, ensure that the amount of physical memory (RAM) in your workstations is always larger than the amount of memory consumed by NX, plus all the other applications that are running at the same time on the same machine. This can be done by using a tool such as Windows Task Manager or Resource Monitor.

The minimum memory requirements varies and depends on various factors including:

- Complexity of the geometry within individual parts
- Size of the assemblies that are loaded
  - Less memory is required if the assemblies contain multiple instances of the same components.
  - More memory is required when large assemblies contain lots of unique components with complex geometry.
- Use of Teamcenter in addition to NX
  - Some additional memory is required when using Teamcenter 4-tier.
  - A even greater amount of memory is required when using Teamcenter 2-tier.
- Fully loading exact assemblies versus using lightweight assemblies and partial loading
- Generating CAM toolpaths for very complex geometry, such as an automotive engine block or gearbox
- Updating large assembly drawings

**Graphics adapters**

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements and are fully supported by our hardware partners. The graphics adapters supported are carefully selected by working with our OEM partners as well as our graphics vendor partners. We do not recommend low-end, consumer, or game cards, since these graphics devices are developed for the DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware problems are graphics related, it is critical that all the graphics adapters that NX supports are designed for OpenGL and have the highest level of support from our hardware vendors. We highly recommend that you only use supported graphics adapters and Siemens PLM Software certified drivers.

For the latest information on certified graphics cards and driver versions, please visit the Customer Support (GTAC) Web site.
Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary due to the large number of possible configurations. Other combinations may work, but these conditions are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in the future.

The following is a summary of findings for the support of multiple monitors.

- NX 6.0.1 or higher - no older releases are supported.
- Two monitors only.
- LCD monitors only.
- Run with native resolution and aspect ratio.
- Laptops are tested without docking stations or port replicators (direct connection only).
- Horizontal Scan mode (not Vertical) and only with identical monitors.
- Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to duplicate the problem on the configurations in our labs before being able to investigate your issues.

Operating system requirements

Operating system requirements

This section documents operating system and service pack requirements.

Minimum Operating Systems

The following operating systems are the minimum recommended for NX. Newer versions and service packs are available as they are released.

<table>
<thead>
<tr>
<th>O.S.</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (64-bit)</td>
<td>Microsoft Windows 10 Pro and Enterprise editions</td>
</tr>
<tr>
<td>Linux (64-bit)</td>
<td>SuSE Linux Enterprise Server/Desktop 12</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux Server/Desktop 7</td>
</tr>
</tbody>
</table>
Linux

Starting in NX 1847, NX is no longer supported on the Linux operating system for interactive NX (NX running with UI), which includes graphics and XESS integration. It is only supported for running solvers and NX Open batch programs with no user interface calls.

Contact GTAC for the new NX Linux product.

Mac OS X

Starting in NX 1847, the Mac OS X operating system is no longer supported.

Windows 10

Windows 10 is the minimum supported release for NX 1872. The supported versions of Windows 10 are the Pro and Enterprise editions utilizing Semi-Annual Channel (SAC) updates.

Windows 10 is also available for NX 10.0.3 and later versions up to NX 1872. Any caveats or special instructions are provided in the SFB announcing support.

Windows 7 and 8.1

Windows 7 has reached the end of life and mainstream support has ended. Windows 8.1 is still supported by Microsoft, but was rarely deployed. These two versions of Windows are no longer supported by NX 1847. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 1872 running on these operating systems. If NX 1872 is deployed on these versions of Windows, any issues will have to be replicated on Windows 10 before filing an incident report with GTAC.

Windows XP and Vista

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of Windows are not supported by NX 1847. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 1847 running on these operating systems. If NX 1847 is deployed on these versions of Windows, any issues will have to be replicated on Windows 10 before filing an incident report with GTAC.

System error when running NX

If you receive the following system error when launching NX, the problem is generally that the operating system is not up-to-date for the required and optional updates. This error can occur with Windows 7 and Windows 8.1.

   The program can't start because api-ms-win-crt-heap-l1-1-0.dll is missing from your computer.
The error occurs when there are missing Visual C++ libraries due to a dependency on the Universal CRT libraries in Visual C++ 2015. To fix the problem, install the **Visual C++ 2015 update 3 redistributable** from Microsoft. The 64-bit redistributable (vc_redist.x64.exe) is available in the INSTALL folder of the NX runtime environment after installation, or you can download the redistributable from Microsoft.

If you still have a problem, contact GTAC support.

**Linux Distributions**

NX is developed using Linux standards and accepted Linux development conventions. Quality assurance testing is performed on the two versions of Linux listed in the table above. Siemens PLM Software cannot guarantee operation, performance, compatibility, or support on any other distributions.

The following is a list of information about the NX 1872 development environment (for reference only):

<table>
<thead>
<tr>
<th>Kernel</th>
<th>kernel3.10.0-123.el7.x86_64</th>
</tr>
</thead>
<tbody>
<tr>
<td>C, C++ Compiler</td>
<td>gcc 4.8.2</td>
</tr>
<tr>
<td>Java Development version</td>
<td>1.8.0_45</td>
</tr>
</tbody>
</table>

**Considerations and caveats**

**Linux Requirements**

NX supports SuSE Linux and Red Hat Linux, both 64-bit only. The minimum supported version of SuSE Enterprise (Desktop/Server) is 12 and Red Hat Enterprise (Desktop/Server) is 7.0. Newer versions will be supported via certification.

Visit the [Customer Support (GTAC) Web site](https://www.siemens.com/) for details of supported hardware configurations as well as for the latest graphics drivers.

**Java Runtime Environment**

The Java Runtime Environment (JRE) is not shipped with NX, but NX does require JRE 8 for certain products. To install the JRE, visit the Java download site at [http://java.com/en/download/index.jsp](http://java.com/en/download/index.jsp)

Java is used for the following products:

- NX Relations Browser
- Manufacturing – Process Studio Author
- Command line version of the following translators:
  - CATIA V4
• CATIA V5
• Dxfdwg
• IGES
• NX Pro E
• Step AP203
• Step AP214
• Knowledge Fusion ICE
• Quality Dashboard
• Validation Rule Editor
• Simcenter 3D Batch Mesher
• Simcenter 3D Response Analysis Function Tools
• Simcenter 3D Report Writer
• Customer written NX Open Java programs

Java requirements for NX Open

NX Open for Java is designed to be used with Java version 1.8.0_45 or higher.

Post Processing of Abaqus ODB format results

In the NX release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.

Note:
If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should already be installed.

You can download this runtime from the Simulia customer support website: http://www.3ds.com/products-services/simulia/support/

For more information on the system requirements for ODB version 6.12 files, see: http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products
Running Samcef in parallel

On Windows, when you run parallel computations with the built-in Samcef solver, Python 2.7 is required. In NX 1847, that version of Python is not present. Install Python 2.7 on your disk and ensure that the Python directory is named Python27 (default name) and is included on your PATH variable.

You can download the software from the Python website: https://www.python.org/downloads/

Note:
The Python requirement does not apply if you have Samcef installed separately from NX.

Configuration files

Starting with NX 12, the NX configuration files on Windows are written to C:\users\<name>\AppData\Local\Siemens.

Installing the .NET Framework

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework component. Before you can execute a custom .NET application, you must install the .NET Framework 4.6.2. In addition, to replay a .NET journal, the .NET Framework 4.6.2 must be installed.

To download the .NET Framework 4.6.2, use the links on this page: Microsoft .NET Framework 4.6 (Web Installer).

Visual Studio runtime redistributable

To run NX 1872, the MS Visual Studio 2017 runtime redistributable is required. In addition, the MS Visual Studio 2013 runtime redistributable is required to properly setup some system dll files for some of the older executables.

You can download the Visual Studio 2017 redistributable here.

You can download the Visual Studio 2013 redistributable here.

Note:
If you have MS Visual Studio 2017 and 2013 installed, you don't need to download and install the redistributable.
Supported hardware and graphics

The list of currently supported hardware and graphics cards can be found on the GTAC support page Customer Support (GTAC) Web site at Hardware and Software Certification→Hardware (Graphics Card) Certifications. This opens a spreadsheet that has tabs for supported systems and graphics.
NX Open programs on Linux

If you try to link an external NX Open C++ program using the *ufmenu* and *uflink* scripts with NX 1872 on SLES 12, Linux may fail with an error message such as:

```
/usr/x86_64-suse-linux/bin/ld: cannot find -lelf
```

For NX to properly build an NX Open program, you must have the correct RPM kits installed.

For NX 1872 and SUSE 12, the following packages are required:

- `elfutils-0.158-3.200.x86_64.rpm`
- `libelf1-0.158-3.200.x86_64.rpm`
- `libelf-devel-0.158-3.200.x86_64.rpm`

For NX 1847 and RedHat 7, the following packages are required:

- `elfutils-libelf-0.158-3.el7.x86_64.rpm`
- `elfutils-libelf-devel-0.158-3.el7.x86_64.rpm`
- `elfutils-devel-0.158-3.el7.x86_64.rpm`
- `elfutils-libelf-0.158-3.el7.x86_64.rpm`
- `elfutils-libs-0.158-3.el7.x86_64.rpm`

**Note:**

For SUSE, the *devel* packages are available from the optional SLE 12 SDK DVD/ISO.
Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory Java is able to report back an error code indicating this problem. However, in some cases Java reports a generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an unexpected error due to this problem.

If NX detects that there is not enough memory available for the JVM, an error message is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block available is outputted below.
Windows largest block free
=================================
Maximum block 267Mb
=================================
Please note, this number is to be used as suggestion for setting the heap size. It is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use the /3GB switch or its equivalent, if available for the Operating System you are on.
Otherwise your other option is to use Remoting. Please consult the NX Open Programmer’s Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose File→Execute→Override Java Parameters to open the dialog box and set UGII_JVM_OPTIONS to the size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already started then you cannot change the UGII_JVM_OPTIONS setting.

It is recommended that you use both the –Xmx and –Xms options together. Both of these are needed as Java may determine default values for the heap size that are not possible with the machine’s current memory load. For example:

UGII_JVM_OPTIONS=–Xmx=50M –Xms=50M
When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java program you are trying to run may not run. This could be due to the amount of memory available on the machine, or due to multiple Java processes running. This can be the case with the Wave Browser where there is a client and server process.

Once you find a value that works, you can modify the UGI_JVM_OPTIONS value in the ugii_env.dat file so you don’t have to reset it in the NX Open Java Parameters dialog box each time you start an NX session.
NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env_ug.dat file contains the standard environment variables for NX. You can override these variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new values for the environment variables in this file and they take precedence over the values defined in the ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>/ugii.

Note:
You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file. However, it is recommended that you use the ugii_env.dat file to define all of the values in use at your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

• Define the variables before the #include statement.

• The first variable defined is used. If you have the variable defined twice in the file, only the first one is used.

Note:
This also applies to the ugii_env_ug.dat file.

• You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

    UGII_ENV_FILE=G:\common\version_env_vars.corp_standards
Statements you can use in the ugii_env.dat file

The statements that you can use in the ugii_env.dat file are shown below with examples:

- **#if/#else/#endif**
  Used to check for specific conditions and then to define variables based on those conditions. Conditions that can be checked are:

  - **FILE** - Check for the existence of a file

    ```
    #if FILE ${UGII_BASE_DIR}\UGII\html_files\start_{$UGII_LANG}.html
    UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_{$UGII_LANG}.html
    #else
    UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_english.html
    #endif
    ```

  - **platform** - Check for a specific platform. Possible values:

    - x64wnt
    - lnx64
    - macosx

    ```
    #if lnx64
    UGII_CAM_THREAD_MILL=${UGII_CAM_THREAD_MILL_DIR}thrm.so
    #endif
    ```

  - **$variable = “value”** - Check for a specific value for a previously defined environment variable

    ```
    #if $UGII_LANG = "simpl_chinese"
    UGII_COUNTRY=prc
    UGII_COUNTRY_TEMPLATES=${UGII_BASE_DIR}\localization\$UGII_COUNTRY\simpl_chinese
    #endif
    ```

  - **$variable != “value”** - Check for a previously defined environment variable that does not have the specified value.

    ```
    #if ${UGII_PACKAGE_DIRECTORY} != ""
    #if FILE ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
    ```

Note:
The file can have any name but must be a fully qualified path.
Enabling context sensitive help in local languages for customer defaults and KF

When using localized language versions of the NX Help, to get context sensitive help to work for Customer Defaults or Knowledge Fusion you need to edit the following two environment variables to point to the localized help:

• UGII_CSHELP_DEFAULTS_DOCS

• UGII_CSHELP_FUSION_DOCS

For example, to enable context sensitive help for Japanese Customer Defaults help you would set:

UGII_CSHELP_DEFAULTS_DOCS=${UGII_UGDOC_BASE}/data_services/resources/nx/${UGII_MAJOR_VERSION}/nx_help/ja_JP/graphics/fileLibrary/nx/cust_defaults

Browser requirements

Browser and plug-in requirements

The NX suite of documentation (Help, What's new Guide, and Release Notes) is provided in an HTML format that is displayed in your local Web browser.

The documentation requires a web server. You can install the Siemens PLM Documentation Server, which sets up a local web server on each workstation, or install the documentation into an existing company-wide server.

The latest versions of web browsers are recommended to comply with the latest browser security updates.

Windows browser support

• Internet Explorer

• Microsoft Edge
• Mozilla Firefox

• Google Chrome

**Downloading browsers**

These browsers are free and can be downloaded from the following Web sites:

- **Internet Explorer** — [http://www.microsoft.com](http://www.microsoft.com)
- **Firefox** — [http://www.mozilla.org](http://www.mozilla.org)
- **Safari** — [http://www.apple.com](http://www.apple.com)

**Windows .chm files**

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security enhancements prohibit opening .chm Help files across a network, so you must install those files on your computer. If you install .chm Help files on a server, you cannot read the Help across the network.

**Adobe Flash Player required for videos**

To watch videos and simulations, you must have the Adobe Flash Player installed as a plug-in to your browser. You can download the Flash Player (free) at the [Adobe Flash Player site](http://get.adobe.com/flashplayer/).

**Adobe Acrobat Reader**

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can download the free reader from [http://get.adobe.com/reader/](http://get.adobe.com/reader/).
Browser caveats

Browser caveats for Firefox

• Mozilla recommends that you upgrade to the latest version of Firefox due to security issues surrounding Java. They do not recommend using older versions of Firefox. For more information, see http://support.mozilla.org/en-US/kb/latest-firefox-issues.

• The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the behavior of the global search since new links will open in a tab instead of a new window. You can configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.

• Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you want to launch from a UNC path (file:///), Firefox has a default security setting that prevents the Help from launching correctly. To enable this, you need to change the value of the security.fileuri.strict_origin_policy preference:

1. In the address bar, type about:config.
2. In the Filter field, type security.fileuri. If the value of the security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-click on the value to toggle it.
3. Restart the browser.

• If you are trying to open a .chm file that you have accessed from a web server (not from a local install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://code.google.com/p/chromium/issues/detail?id=39767.

Browser caveats for Adobe Flash Player

The following is applicable for the Adobe Flash Player:

• Chrome blocks Flash.

• Firefox blocks Flash by default. However, you can manually enable the Flash plugin for the Windows 64 bit browser.

• Internet Explorer blocks Flash by default. However, you can manually enable the plugin.
• Microsoft Edge blocks Flash.

Licensing Caveats

General licensing caveats

License files and license server

The following are applicable to license files and the license server:

• Merging of license files is not supported.

Example:
You can not merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the `uglmd` license daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the `ugslmd` daemon.

NX requires and tests for the latest version of the `ugslmd` vendor daemon. This vendor daemon is supplied with NX and must be installed and initiated prior to starting NX. If an older daemon is utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog will contain an error message that the daemon version is older than the client.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX 1847 borrowing tool will work for NX 1847 but cannot be used to run NX 12. In addition, you cannot borrow licenses for two NX versions simultaneously on the same workstation.
Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

License Option tool

The License Option tool should only be used to borrow NX licenses, even though it may display other licenses. The License Option tool does not filter features in the license file that are of an earlier version than NX, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool. Attempting to borrow a license other than NX causes an error in the License Option tool.
Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

- LSB 4.0
Product compatibility - supported version combinations

Teamcenter and NX

The following table lists the version combinations of Teamcenter, Active Workspace, and NX that are supported.

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>NX 12</th>
<th>NX 12.0.1</th>
<th>NX 12.0.1 MP1</th>
<th>NX 12.0.2</th>
<th>NX 1847 Series</th>
<th>NX 1872 Series</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TC 10.1.7</td>
<td>TC 10.1.7</td>
<td>TC 10.1.7</td>
<td>TC 10.1.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.2</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TC 11.3.0.1_a01</td>
<td>TC 11.3.0.1_a01</td>
<td>TC 11.3.0.1_a01</td>
<td>TC 11.3.0.1_a01_patch_5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AW 4.0</td>
<td>AW 4.1</td>
<td>AW 3.4</td>
<td>AW 3.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.3</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AW 4.0</td>
<td>AW 4.1</td>
<td>AW 3.4</td>
<td>AW 4.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.4</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td></td>
<td>TC 11.4.0_patch_5</td>
<td>TC 11.4.0_patch_5</td>
<td>TC 11.4.0_patch_5</td>
<td>TC 11.4.0_patch_15</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AW 3.4</td>
<td>AW 4.0</td>
<td>AW 4.1</td>
<td>AW 4.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.5</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

Note:
- TC is Teamcenter
- AW is Active Workspace
- The versions specified are the minimum required and later versions in the series are also applicable, unless otherwise specified. For example, TC 11.4.0_patch_5 also includes patch_6, patch_7 and so on, that is, TC 11.4.0_patch_5 or higher.
- The NX release series identifies the monthly updates, where applicable. For example, the NX 1847 series includes the NX 1851 update, where applicable.
<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>AW 4.0</th>
<th>AW 4.1</th>
<th>AW 4.2</th>
<th>AW 4.0</th>
<th>AW 4.1</th>
<th>AW 4.2</th>
<th>TC 11.5.0_patch_10</th>
<th>AW 4.0</th>
<th>AW 4.1</th>
<th>AW 4.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teamcenter UA 11.6</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Teamcenter UA 12.0</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Teamcenter UA 12.1</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Teamcenter UA 12.2</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

**Note:**
For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization, see the Teamcenter documentation.
NX compatibility with Spreadsheet

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>NX 1872</td>
<td>Windows</td>
<td>Windows 10 64–bit</td>
<td>10 Pro &amp; Enterprise</td>
<td>Certified &amp; supported</td>
<td>MS Excel 2016 (32–bit)</td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Windows 8 64–bit</td>
<td>8 Pro &amp; Enterprise</td>
<td>Certified &amp; supported</td>
<td></td>
<td>MS Excel 2013 (32–bit)</td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Windows 7 64–bit</td>
<td>7 Pro &amp; Enterprise</td>
<td>Certified &amp; supported</td>
<td></td>
<td>MS Excel 2010 (32–bit)</td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Windows 8 64–bit</td>
<td>8 Pro &amp; Enterprise</td>
<td>Certified &amp; supported</td>
<td></td>
<td>MS Excel 2007 (32–bit)</td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>Windows 7 64–bit</td>
<td>7 Pro &amp; Enterprise</td>
<td>Certified &amp; supported</td>
<td></td>
<td>MS Excel 2003 (32–bit)</td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

Note:

- The 64-bit versions of Microsoft Excel are supported starting in NX 12. The 32-bit version of Excel is installed by default on the Windows 64-bit Operating Systems.

- Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's, Math and Equation Editing.

- If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates the data to Excel 2007 or later (to the Excel version currently running with NX).

- If you launch a spreadsheet command such as Spreadsheet or Part Family on a system having Excel 2003 or older version as the default spreadsheet application, NX displays an error message and does not proceed with the launched command.

NX support for the currently supported versions of Microsoft Office will be discontinued as per the following dates:

<table>
<thead>
<tr>
<th>Microsoft Office version</th>
<th>End of support</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td>October 11, 2017</td>
</tr>
<tr>
<td>2010</td>
<td>October 13, 2020</td>
</tr>
<tr>
<td>2013</td>
<td>April 11, 2023</td>
</tr>
<tr>
<td>2016</td>
<td>October 14, 2025</td>
</tr>
</tbody>
</table>
NX applications unsupported on specific platforms

The applications listed are not supported on the specified platforms.

<table>
<thead>
<tr>
<th>Application</th>
<th>Functionality</th>
<th>Platform not supported on:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tooling &amp; Fixture Design</td>
<td>NX EasyFill Analysis - Advanced</td>
<td>Linux</td>
</tr>
<tr>
<td>NX Translators &amp; Open Tools</td>
<td>NX Open Python Author</td>
<td>Linux</td>
</tr>
<tr>
<td>Electro-Mechanical Design</td>
<td>Mechatronics Concept Designer</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Drafting</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Additive Design with Convergent</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Layout</td>
<td>Linux</td>
</tr>
<tr>
<td>NX Translators &amp; Open Tools</td>
<td>Content Migration Manager for SolidWorks</td>
<td>Linux</td>
</tr>
<tr>
<td>NX Translators &amp; Open Tools</td>
<td>CMM Drawing Repair Assistant</td>
<td>Linux</td>
</tr>
<tr>
<td>Electro-Mechanical Design</td>
<td>ELMA</td>
<td>Linux</td>
</tr>
<tr>
<td>Electro-Mechanical Design</td>
<td>NX Piping Fabrication Drawings &amp; PMI</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Lattice Structures Design</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanic Design</td>
<td>NX Ship Structure PMI Creation</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Ship Dimensions &amp; Adv Annotation</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>Drawing Automation for NX (version 10 and later)</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>Layout for NX</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Aerospace Design</td>
<td>Linux</td>
</tr>
<tr>
<td>Mechanical Design</td>
<td>NX Lattice Structures Design</td>
<td>Linux</td>
</tr>
<tr>
<td>Gateway</td>
<td>Advanced Studio Rendering Style Mode</td>
<td>Linux</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>Abaqus OBD result file reading</td>
<td>Linux</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>Topology Optimization and Shape Optimization</td>
<td>Linux Redhat</td>
</tr>
<tr>
<td>Motion</td>
<td>Motion Mechatronics co-simulation</td>
<td>Linux</td>
</tr>
</tbody>
</table>
Support for touch enabled devices

In NX 1872, you can interact and manipulate 3D models and control the overall user interface using touch screen and stylus. The support for touch enabled hardware follows a slightly different support model than what is provided through the NX certification program. We have tested NX on a number of Windows based touch screen laptops, monitors, and tablets. However, support for these devices and other comparable systems is limited as they are not true workstations and do not qualify for our full certification program. Support for these devices is limited as follows:

- Graphics performance issues are not supported as most of these devices do not offer the level of driver support available on workstations.

- Graphics quality and display issues are not supported unless they can be duplicated on a certified workstation.

- Any issue determined to be caused by the graphics driver is not supported.

- Performance issues with NX are not supported on these systems unless reproducible on certified workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell, Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

- NX supports touch devices on the Windows operating system.

- Only stylus configurations support pre-highlighting. The most commonly used devices supporting stylus are the Surface Pros.
1. System Information
2. Teamcenter Integration for NX

Product Notes

Refile utility to be retired

Historically, the NX product release has included the refile utility, which was created many years ago for very specific data conditions and was never intended to be run by all customers on all of their data. This utility was never mandatory when performing NX upgrades.

NX product enhancements and improvements that are delivered and available in the current NX release make NX upgrades much faster and easier, so the refile utility is now obsolete. As a result, the refile utility is retired starting in NX 12.0.1. The documentation for the utility has already been removed in NX 12.

In place of the refile utility, standalone utilities will be introduced that incorporate non-version-up related options and future NX batch processes.
Caveats

Listing order for JT assemblies in Assembly Navigator

The listing order of items you have set in the Assembly Navigator is not maintained for JT assemblies if you reopen the assembly. To get the set listing order for the JT assemblies, you need to save the top JT assembly with the master dataset.
3. Fundamentals

Product Notes

NX Virtual Reality display environment

The NX VR environment operates within the following display framework:

• The color of geometry comes from the NX component or object color (Edit Object Display→General tab, Basic group→Color). Color does not come from the True Shading material, Studio material, face, or facet color.

• Only solid-body, facet-body, and sheet geometry is displayed in the VR environment.

• The VR environment does not support translucency in the display.

• Geometry tessellation quality follows NX graphics window tessellation quality.

The following NVIDIA VR system is supported for NX Virtual Reality:


Refile utility to be retired

Historically, the NX product release has included the refile utility, which was created many years ago for very specific data conditions and was never intended to be run by all customers on all of their data. This utility was never mandatory when performing NX upgrades.

NX product enhancements and improvements that are delivered and available in the current NX release make NX upgrades much faster and easier, so the refile utility is now obsolete. As a result, the refile utility is retired starting in NX 12.0.1. The documentation for the utility has already been removed in NX 12.

In place of the refile utility, standalone utilities will be introduced that incorporate non-version-up related options and future NX batch processes.

Unit Manager settings

When you run the ug_convert_part tool to convert an NX 12 part from mm to inch, the settings in the Unit Manager dialog box do not display the converted units. This is as intended.

The Units Manager dialog box displays the units that you have selected as the default units for data entry and object information output. Those units are independent of the underlying part units (metric or inch).
Ray Traced Studio

To maximize rendering performance for Ray Traced Studio in NX 1872 with Iray+ v4.2 / NVIDIA Iray v2018.0.1 and an NVIDIA Quadro GPU, you will need an NVIDIA Quadro graphics driver supporting CUDA 9.0 or higher (NVIDIA Quadro driver versions 384 and later).

CUDA 9.0 supports NVIDIA Quadro GPUs with CUDA Compute Capability 3.0 and higher.

This means support of the Fermi class GPUs (Quadro 2000, Quadro 2000D, Quadro 600, Quadro 4000M, Quadro 3000M, Quadro 2000M, Quadro 1000M, Quadro 6000, Quadro 5000, Quadro 4000, Quadro Plex 7000, Quadro 5010M, Quadro 5000M) has been removed. These cards have also been labelled “EOL” in the GTAC Hardware (Graphics Card) Certifications spreadsheet.

For specific NVIDIA driver versions, please contact GTAC.

Tip:
You can obtain the current CUDA version supported for your NVIDIA graphics driver by using the NVIDIA Control Panel → System Information → Components tab → 3D Settings → <Product Name for NVCUDA>.

Cursor speed and shake gesture

Pressing MB1 and shaking the mouse from side to side is a new gesture called UGUI_MOUSE_SHAKE. This new gesture is reported to GIT clients whenever a user shakes the mouse.

An API is implemented to provide the value of the pointer speed at a given mouse movement gesture. This data is only valid if the current gesture is UGUI_PRE_POSITION or UGUI_DRAG_POSITION.

Navigate tool is retired

The Navigate tool is retired. You can explore your design in 3D space using Fly-through.
Caveats

**NX Virtual Reality and Windows Mixed Reality**

Windows update version 1809 creates a number of issues with NX VR and Windows Mixed Reality, including frame rate drops. We therefore recommend only updating Windows to version 1803.

**Bookmarks**

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray Traced Studio mode is not in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when

1. the bookmark file is not for the current displayed part and
2. the number of views in the layout at the time when the bookmark file was created is not the same as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the same bookmark file a second time corrects the number of views.
4. Customer Defaults

Customer defaults

Customer defaults allow you to customize the operation of NX. The initial settings and parameters of many functions and dialog boxes are controlled by customer defaults. You can view them by choosing File→Utilities→Customer Defaults.

For a description of the new or modified customer defaults, see Customer Defaults for NX 1872.

For additional information on customer defaults, see System administration→Customizing the NX installation→Customer Defaults in the NX online help. For a listing and description of all customer defaults, see Fundamentals→Customer Defaults in the NX online help.
5. Design (CAD)

Assemblies

Caveats

Minimal loading of JT files

You cannot minimally load a monolithic JT file, which is a single file that contains the entire structure and its piece part information.

Mirror Assembly

When you move a mirror plane while both the Mirror the absolute origin location of all mirrored assemblies or components option and the Associative Mirror option are set, the location of the mirrored assembly or components updates, but the mirrored absolute origin does not update.

Minimally Load - Lightweight Display

The following caveats apply when you load assemblies using the Minimally Load - Lightweight Display option:

- Avoid using this load option with the Structure Only load scope. You may experience lower load performance when you use them together to load components from the Assembly Navigator, or in conjunction with the Open by Proximity command.

- If you use this load option to load assemblies that have the following characteristics, the components will be loaded partially instead of minimally:
  - Pre-NX 9 components
  - Components without NX datasets (JT components)
  - Geometry overrides
  - Position overrides
  - Suppression overrides
  - Reference-only components
  - Assembly-level facets

- The associativity between multi-CAD override geometry and NX objects, such as PMI, will not be maintained when assemblies are loaded using the Minimally Load – Lightweight Display assembly load option.

Component patterns

When the setting of your Move Component Scope customer default is Anywhere in Assembly, NX ignores this setting if the active window's root part or any of its subassemblies contain any component
patterns. When you move components in this situation, the **Move Component** command behaves as though the **Move Component Scope** customer default is set to **Work Part Only**.

When a subassembly of the active window's root part contains a component pattern, inserting a motion step in your sequence that affects a member of the component pattern may cause incorrect movement of the following:

- Members of the component pattern.
- Components directly constrained to the pattern members.
- Components indirectly constrained to the pattern members.

**Note:**
When component patterns are present only in the active window's root part, the **Insert Motion** command works correctly.

**Reflect Component**

You can't:

- Create a component pattern for reflected components.
- Export reflected components using the **Export VRML** command.
- Use NX 12.0.2 assemblies that contain reflected components in NX 12 or NX 12.0.1 because they don't support reflected components.

Reflected components are limited or aren't supported in some applications and tools:

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAM</td>
<td>CAM doesn't support assemblies with reflected components. Although you can perform programming on reflected components, the results may be unpredictable.</td>
</tr>
<tr>
<td>PTS</td>
<td>Product Template Studio (PTS) templates don't support moving reflected components.</td>
</tr>
<tr>
<td>Motion</td>
<td>You can't start the Motion application if your assembly contains any reflected components.</td>
</tr>
<tr>
<td>Simcenter 3D 3D Pre/Post</td>
<td>If you start the Simcenter 3D 3D Pre/Post application, all reflected components are removed from your assembly.</td>
</tr>
<tr>
<td>Fixture Planner and Line Designer</td>
<td>For Fixture Planner and Line Designer, we recommend disabling assembly reflection for the following reasons:</td>
</tr>
</tbody>
</table>
• We believe that it doesn’t make sense to use reflected components for any equipment in the plant structure or Bill of Equipment, because such equipment isn’t purchasable. For example, robots or conveyors aren’t available in reflected versions.

• Downstream applications like Process Simulate don’t support reflected components in the plant structure.

• For Fixture Planner, reflected assemblies in the product structure aren’t supported because features like weld points and locators must have unique identifiers for left-hand and right-hand parts. Features and locators must also be associated to either a right-hand part or a left-hand part.

Drafting

Product Notes

Enhancement for spherical and toroidal dimensions

Drafting dimensions for spherical surfaces will now automatically be displayed with an $SØ$ prefix for diametrical dimensions and $SR$ for radial dimension. Use the Diameter Symbol and Radial Symbol preferences to adjust prefixes for these dimension types.

Commands to be retired in a future release of NX

The following commands will be retired in a future release of NX and are now hidden so that Command Finder will no longer list them

• Edit→Annotation→Edit Text

The command is under an environment variable and the Command Finder will not list it. If you need access to the command, please contact GTAC.
Caveats

Appearance of hidden curves with minimally loaded components

When you minimally load a component, hidden curves for that component may appear in your drafting views when you hover your mouse cursor over the view. This usually occurs while adding annotation to views with a Smart Lightweight representation. To remove the hidden curves from the view, you must manually update the view.

Performance caveats

You may encounter errors when doing any of the following:

- Creating half section views.

- Working with drafting views that have a Pre-NX8.5 view representation.

- Working with multi-CAD assemblies in native mode.

Out of date drawing status for minimally loaded components

When you load a multi-CAD assembly drawing using the Minimally Load - Lightweight Display option, your drawing may appear out of date if the following conditions apply.

- If the Default Unit customer default is set to a unit (for example, MM) that is different than the part unit of the JT part in the multi-CAD assembly (for example, INCHES), then the drawing will always appear out of date when it is first opened.

- If your multi-CAD assembly drawing contains one or more of the following object types, it may appear out of date when it is first opened.

  - Inherited PMI region.

  - Imported PMI section view.

  - Hole table.

  - Detail view.
Layout

Product Notes

Create from 3D

When you use the Create from 3D command, you can now select lightweight components without first setting the Load Smart Lightweight Data customer default. Assembly performance improvements made that default obsolete in NX 12.0. Now smart lightweight data is loaded whenever NX needs it to complete an action.

Product and Manufacturing Information (PMI)

Product Notes

PMI section view enhancement

PMI section view algorithms are enhanced so that section cut curves and crosshatch patterns are correctly generated when the section cut plane is tangent to a planar face.

To implement these enhancements in existing PMI section views, you must use the Renew command to update your model.

Technical Data Package usability enhancements

Several enhancements are implemented to improve the usability of the Technical Data Package (TDP) functionality. These enhancements include:

- Improved loading times.
- You can now reorder and insert new pages.
- A new All Views option lets you publish all supported views in your model.
- A more streamlined top border bar and Table dialog box.
- Standard alert messages.
- A more intuitive interaction with preview images and inserted object.

Commands to be retired in a future release of NX

The following commands will be retired in a future release of NX and are now hidden so that Command Finder will no longer list them.
The command is under an environment variable and the **Command Finder** will not list it. If you need access to the command, please contact GTAC.

**Ship Structure**

**Caveats**

**Copy Parts between Planes**

The **Copy Parts between Planes** command does not support **Extrude** features that are created using the **Stop at Intersection** selection rule.

**Sheet Metal**

**Caveats**

**Patterning of a gusset on non-cylindrical bends**

When a gusset is on a non-cylindrical bend, you cannot create a pattern of the gusset.

**Note:**

This is applicable only for gussets created using **Automatic Profile**.

To create a pattern of a gusset that exists on a non-cylindrical bend:

1. Extract the curve of the mold edge of the non-cylindrical bend. For example, use **Offset Curve in Face** to extract the curve.
2. Use the extracted curve for defining the plane location and create a gusset.
3. Pattern the gusset using the extracted curve as a path.

**Tip:**

To do this, use **Along** in the **Layout** list.

**Bridge Bend**

You cannot create a bridge bend if the two sheet metal bodies intersect in the following way:
• A body from which you select an end edge intersects with the non-planar web face of the parent body of start edge.

![Diagram showing start and end edge](image)

1. Start edge
2. End edge

**Convert to sheet metal**

If you create a fold transition between the planar web faces of chained bends and convert the body to a sheet metal part, the conversion may be partially successful.

**Exporting multi-segment lofted flanges to Trumpf GEO format**

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO format.

**Creating multiple flanges**

While creating multiple flanges, if adjacent flange edges are not in the same set, you cannot apply an internal miter.

**Unite in Sheet Metal**

If you unite bodies that consist of Sheet Metal and advanced Sheet Metal features, the united body may not support subsequent Sheet Metal operations.

**Material and Bend tables**

The tool selection options are not available for the following commands and options.

- **Hem Flange**
- **Lofted Flange**
- **Convert to Sheet Metal**
- **Bridge Bend → Type group → Z or U Transition**
Human Modeling

Product Notes

Predict posture algorithm updates for class A vehicles

In this release, the posture prediction algorithms for Class A vehicles are updated. The new models from the University of Michigan Transportation Research Institute (UMTRI) now also consider the age and gender of the occupant.
Documentation Notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled Hands-on: <Procedure name>.

PCB Exchange

Caveats

Flat Solid workflow

The import and export of ECAD models in their bend state only works when the board is a solid body. If the board is an assembly component this workflow does not work.

PCB Exchange for Zuken

CR5000 Data Server version 17 or later requires the Visual C++ 2012 Redistributable package to be installed. You can download it from the Microsoft website.
6. Manufacturing (CAM)

Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in NX documentation.
CAM Early Validation Program

Some of the new NX CAM features are available only upon request through the CAM Early Validation Program (EVP). In order to learn more about these pre-release features, please contact GTAC. GTAC will forward your request to the appropriate development contact.

The early access features available in the current release include the following:

- Additive Manufacturing: Print mark support
- Holemaking in-process workpiece: Blank thickness
- Hole milling and thread milling: Cycle output
- Turning: Multi-channel operation
- Turning: Feed rates from chip thickness
- Turning: Optimized cut pattern
- Split IPW: Define automatic scrap detection

Access to some early functionality is controlled by feature toggles. (File → Utilities → Feature Toggles)

- Refactored Machining Feature Navigator
- Manufacturing Compare Tool
Tool path and template changes

Tool path changes

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements, and improve reliability. In many cases, you may see some differences between the new path and the old path when you generate an operation from a previous release. If you rely on automatic methods, these changes should be acceptable. The end result of the new path should be comparable to, or better than, the previous path.

To prevent accidental changes to tool paths in part files from a previous release, use the Lock Tool Paths During Version Upgrade customer default. This option automatically locks all operations with an edit status of Complete or Repost.

Maintenance release template changes

By default, the template part files for a main release are stored in the mach/resource/template_part folder. Template part files for maintenance releases are stored in the mach/updates/template_part folder.

Ongoing changes

Multiple dialog boxes will change to the explorer tree format in the next major release.

Example of dialog box converted to explorer tree format:
CAM configuration changes

- *dbc_tool_ascii.def*
  Changed the alias `Diameter1` to alias `Diameter` in RSET of `STEP_DRILL`.

Operation template sets

- No changes

Operation templates

Changes apply to English and metric template parts.

- *turning.prt*
  Set the lathe work plane to **ZM – XM**.

- *mill_planar.prt*
Changed the default state of the Preview check box in Floor Wall operations to cleared [ ], to turn it off.

Tool templates

- turning prt
  Grouped the options within the Multi-Tool dialog box.

- multi_axis_deposition.prt, library_dialogs.prt
  - Hard-coded the Deposition Width to By Stepover for Deposition Laser and Material Extruder.
  - Removed Deposition Width from the Deposition Laser and Material Extruder dialog boxes.

Deposition Width is hard-coded to By Stepover, and hidden in the UI, because NX now outputs the height and width values for each point in the operation.

Customized templates

If you create your own template files, you must back up the files before you upgrade to the current release. Copy the template files from the templates folder (%UGII_CAM_BASE_DIR%\mach\templates\) to a separate location to prevent the installation from overriding your defined templates.

After the upgrade installation is done, copy your template files to the %UGII_CAM_BASE_DIR%\mach\templates location.

Merging customized templates

You can merge your customized templates with the templates included in this release in the following ways:

- Start with the new default templates and apply your customizations. This is highly recommended to ensure you receive all the PR fixes.

- Re-file your customized templates in the new release, review the changes listed for the release, and implement the applicable ones in your templates. This method is not recommended, because you will not receive the PR fixes.
General changes

Machine Tool changes

The standard machine tools supplied with NX have revised postprocessors and kinematics models. Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX 8. If necessary, retrieve the machine tool again.
Milling

Floor Wall operations

Releases previous to NX 12.0.1 used a negative stock value to define an additional depth for through holes.

If you used a negative floor stock value instead of the current Z-Depth Offset value to define an additional depth for through holes, and want to maintain the settings, set the following variable:

```
UGII_CAM_FW_INFER_FLOORS_NEG_STOCK =1
```
Integrated Simulation and Verification (ISV)

ISV Simulation

• Support for VNCK 4.8.2 is added, and support for VNCK 2.6 is removed. VNCK 4.8.2 is officially released for Windows 10.

• External file simulation in Teamcenter Integration for NX uses the same file selection box as native NX.

• The MachineConfigurator version 1.0.0.1027, and future versions, support the definition of valid file extensions. We recommend that you use the latest version of the MachineConfigurator, because future CCF files shipped with NX will include such file extension definitions. With NX1872, the new MachineConfigurator version 1.0.0.1220 includes the following:
  • Updated CSE documentation
  • Bugfixes
  • Support for selecting robot controllers
  • Support for VNCK 4.8
  • The latest CCF files for the TNC and Fanuc controllers require the Python controller parser type. When you set Implementation to Python, it is no longer necessary to redefine global variables inside the driver. The driver now obtains the variables directly from the kinematics model.

Note:
If you prefer the library parser approach, use the CCF files from NX 11. You must define global variables inside the driver for this approach.

ISV using CSE simulated controllers with Python parser

• The CSE Python parser is supported for Windows only. This means that the standard examples supplied with NX will not run on non-Windows operating systems. As a workaround: Inside the Machine Configurator, in the Global Settings dialog box, change the Implementation setting for the MCF from Python to Library.

• For existing simulations using Python parser with encrypted files from older versions, for example NX 9 or NX 10, we recommend that you use the un-encrypted *.py files from the latest release.
Feature-based Machining (FBM)

Feature teaching no longer supports the *Inferred* CSYS subtype.
Post

Library posts installed with NX

The Post Builder postprocessors are removed from the standard library machine tools, simxx, delivered with NX. If an existing CAM setup refers to a library entry that used the Post Builder posts, it will not work. You must do one of the following:

• Replace the machine tool with a library entry that uses the Post Configurator post.

• Copy the post from NX 12.0.2, and add it to the current NX library.

Post Configurator and TCL

As of NX 12.0.1 MP1, the NX CAM tcl version is upgraded from TCL version 8.4 to version 8.6. You may need to update your company’s tcl files because TCL version 8.6 has a stricter grammar check.

We recommend that you always edit the Post Configurator postprocessor tcl files in the Post Configurator tcl editor. If you use your own text editor, set the encoding to UTF-8 without BOM.
Machining Line Planner

Multiple product support

You can now plan multiple products on a machining line.
Manufacturing critical maintenance and retirement notices

Retirement of legacy options

The following options are no longer supported, and are removed in the current release.

• The **Trochoidal** cut pattern option.

  Note:
  The **Adaptive Milling** operation should be used instead of the **Trochoidal** cut pattern.

• The radial, concentric, and **Standard Drive** cut patterns for the **Area Milling** drive method.

• The **On Plane** stepover option for the **Area Milling** drive method.

• The **Spiral**, **Boundary**, and **Radial Cut** drive methods for fixed-axis contouring operations.

  Note:
  When these drive methods are used in an existing operation, NX continues to display them in the **Drive Method** list, and to generate the operation.

• The **Use 2D workpiece** option for Area Milling, Flow Cut, and Zlevel operations.

• The **Blank distance** option for Cavity Milling operations.

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author (PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose **Start → All Programs → Siemens NX → Manufacturing → Process Studio Author**

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI architecture.

Point To Point planned retirement from all platforms

**Point To Point** is in critical maintenance. The **Drill** template has been hidden by default, but is still available.

The following operations and geometry objects in the **Drill** template are affected:
• DRILL_GEOM
• SPOT_FACING
• SPOT_DRILLING
• DRILLING
• PECK_DRILLING
• BREAKCHIP_DRILLING
• BORING
• REAMING
• COUNTERBORING
• COUNTERSINKING
• TAPPING

The hole drilling operation introduced in NX 9 should be used instead of the Point To Point module.

The migration of Point To Point operations is not committed at this time, but will be considered for a future release.

The new method to manually drill holes not only replaces the Point To Point module, but it also includes new capabilities such as:

• Sequential Drilling
• Deep Hole Drilling
• Back Countersinking
• Hole Chamfer Milling
• Hole Milling and Boss Milling
• Thread Milling and Boss Thread Milling
• Radial Groove Milling
Manufacturing documentation notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled Hands-on: <Procedure name>.

Manufacturing caveats

General caveats

Reflect Component

NX CAM does not support the Reflect Component assembly command. If you use any geometry from a reflected component for your operation, the results may be unpredictable.

NX CAM plans to support the Reflect Component command in a future release.

NX process

When you exit NX, it may close the UI without stopping the process. There is no data on how widespread this problem is.

Work Instructions

Do not include Documentation operations as the target for the following commands, as unexpected results may occur.

- Parallel Generate
- Replay
- Object Transform
- Simulate
- Gouge Check
- Verify
Shop Documentation

Each time you create Shop Documentation, NX generates facet bodies. To reduce the size of your part file, delete the facet bodies before saving it.

Command Finder: Faceting

Tilt Tool Axis

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortest 2D distance to curve</td>
<td>Use the 3D shortest distance option.</td>
</tr>
<tr>
<td>For longer tool paths, the shortest distance calculation can become unsynchronized.</td>
<td></td>
</tr>
<tr>
<td>The tilted tool path may have non cutting moves with lifts in regions where they are not needed, and the moves can cause gouges.</td>
<td>None</td>
</tr>
</tbody>
</table>

IPW

- A Generic Motion (GMC) operation does not change the machine mode state of the IPW. Adding a Machine Control subop with a Set Modes event at the beginning of the GMC operation does not change the machine mode state of the IPW. The previous machine mode, either milling or turning, remains active.
  - If the preceding operation does not have the required machine mode, you must add an operation with the required machine mode before the Generic Motion operation. For example, if the Generic Motion operation is for turning, add a turning operation. The new operation must generate tool path, but does not need to cut material.

  Note:
  This is not a limitation in ISV when you use the CSE driver. The machine state is defined by the workpiece spindle setting, which is either turning or milling.

- The IPW calculation is inconsistent:
  - For Verify and Simulate, rapid motions do not remove material.
  - When you generate the tool path for operations using the IPW, rapid motions can remove material.

  This difference can result in unexpected results, for example when you use Show 3D IPW.
### Milling caveats

#### Rotary Floor milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Min. Lead Angle</strong> does not influence the tool path.</td>
<td>None</td>
</tr>
</tbody>
</table>
Turning caveats

Turning tools

The tool library does not support the following new parameters on the **Holder** tab of the **Turning Tool-Standard** and **Grooving Tool-Standard** dialog boxes.

- (SH) Shank Height
- Definition Mode
- (CEA) Cutting Edge Angle

The tool library does not support the parameters on the new **Adapter** tab of the **Turning Tool-Standard** and **Grooving Tool-Standard** dialog boxes.

For round shank holders, it is not possible to specify an adapter using only the **Block Length**, **Block Width**, and **Block Height** parameters.
Hole machining caveats

Tapping operations

Drilling and Tapping are distinct operation subtypes. Although tapping cycles are available in the Drilling operation dialog box, we recommend that you do not use a Drilling operation combined with a tapping cycle. The tapping cycles will be removed from the Drilling operation in a future release.

In a Tapping operation, you can set feature geometry parameters, such as pitch, that output the required mom variables for tapping. If you use one of the tapping cycles in a Drilling operation:

• The operation will not contain the necessary feature geometry parameters and in-process feature volumes for tapping.

• You will have the legacy Point to Point output where the pitch is driven by feed rate.

Back Counter Sinking operation

The Gouge Checking option reports false gouges.
ISV caveats

Synchronization Manager

In Windows 10, if you choose **File→Exit** to terminate the NX session, and the **Synchronization Manager** dialog box is open, NX displays Parasolid error messages before terminating the NX session.

Visualize 2D Dynamic

- If blank geometry is not defined, you must click Step Forward twice before NX asks for blank geometry.
- The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the graphics X server settings. For example: NVidia Quadro and FX graphics drivers In the XF86Config file, in the Device section, set CIOverlay to TRUE.

Simulation

- In certain cases the reported minimum distance of a clearance violation is not the closest distance.
- Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not work in some cases. There are also some cases in which the selected positions of rapid motions are not displayed correctly.
- When the simulation runs in the history buffer, and the spindle speed **Output Mode** for an operation is set to **SFM** or **SMM** to maintain constant surface speed, the simulation behavior can be unreliable.
- When you use the **Machine Code Based Simulation** option for synchronized operations, **Show Tool Path** is supported, but **Path Segment Selection** is not supported.
- When you use the **Machine Code Based Simulation** option in the **sim09** machine tool, milling operations using CYCLE800 may have unwanted 360-degree motions of the C-axis.
- When you use the **External Program Simulation** option, and you replace a machine, the software removes the selected external main program from the **Program Manager** dialog box. You then lose all changes in the edited main NC code program. As a workaround, save your main program before replacing the machine.

CSE simulation

- When there are multiple workpiece objects, the tool trace is always attached to the first component classified as **_WORKPIECE**, and moves with the component. If the tool trace is displayed on the wrong component, you can reorder the kinematics tree to place the required **_WORKPIECE** component first.
NX uses the tool tip of the active tracking point, of the active tool, in the carrier.

- To set the active tracking point, use `SetCorrectionSwitch/SetToolCorrection`.
- To set the active tool, use `activateNextTool`.

- When dragging behavior is used (Kv >0), the display and the collision checking are not synchronized.
  
  The graphical display uses the dragged positions.
  
  Collision checking and material removal are based on the ideal interpolated values.
  
  This means that NX may report a collision that is not directly visible inside the graphics window.

**Virtual NC Kernel (VNCK)**

- When it reaches a breakpoint, the simulation may fail to stop or may not stop at the exact position specified.

- Although the supported VNCK versions (4.4, 4.5.2 and 4.7.4) are not officially released for Windows 10, they usually run without any problems when you use **HMI Operate**. If the VNCK does not boot after installing, please ensure that Windows Data Execution Prevention is not active for `vncksl.exe` and `vplc3172dp.exe`.

  1. Press the Windows key.
  2. In the search box, type **advanced system**, and press Enter.
  3. In the **System Properties** dialog box, click the **Advanced** tab.
  4. Under **Performance**, click **Settings**.
  5. Click the **Data Execution Prevention** tab.

  If the **Turn on DEP for all programs and services except those I select** option is selected, you must exclude the `vncksl.exe` and `vplc3172dp.exe` files.

  To exclude the `vncksl.exe` and `vplc3172dp.exe` files:

  1. Click **Add**.
  2. Select the `vncksl.exe` and `vplc3172dp.exe` executable files.

    The default location for both files is the VNCK installation folder.
3. Click OK.

Note:
You must exclude the vncksl.exe and vplc3172dp.exe files for all installed VNCKs.

HMI Advanced

• HMI Advanced is always positioned in the top left corner of the Windows desktop. You cannot move it from there.

• HMI Advanced is always on top of all other applications.

• Starting HMI Advanced resets Windows colors to a specific HMI Advanced color schema.

• When you run HMI Advanced, you can’t use function keys, such as F1, for other programs. The function keys won’t work in the other programs until you exit HMI Advanced.

Additional restrictions:

• Windows 10 is not supported.

Positional ISV — Show Machine Axis Positions dialog box

When the setup has a multi-function machine and you use the dynamic manipulator to change the tool axis for a fixed-axis operation, NX does not update the Show Machine Axis Positions dialog box. To avoid confusion, use the Show Machine Axis Positions customer default to suppress the dialog box.


2. In the Customer Defaults dialog box, choose Manufacturing→User Interface.

3. Click the Dialog Boxes tab, and in the Visibility group, clear the Show Machine Axis Positions Dialog box.

Generate IPW with Path customer default

Using the Generate IPW with Path customer default may cause commands that require the IPW, such as Verify, to have problems when the IPW is not complete. This can happen because the IPW takes more time to generate than the operation.
**Post Configurator**

**DEF File Editor**

The editor removes comments from the main definition file, including any existing comments.

**Canned Cycles**

The drilling depth output is wrong if the depth is deeper than 99 mm.

**Output of spindle orientation for back bore operation**

The spindle orientation might be wrong in some situations.

**UDE Rotate**

The postprocessor might crash in some cases when you add **UDE Rotate** to the operation.

**TCPM prepositioning plane**

When this option is activated, the plane output for the prepositioning is wrong in the following case:

- There is only one MCS in the **Geometry View** of the **Operation Navigator**, and
- The MCS is defined as **Local**, and
- **Special Output** is set to **None**.
Feature based machining caveats

Teach Feature Mapping, Teach Operation Sets

Limitations and workarounds:

<table>
<thead>
<tr>
<th>When you</th>
<th>Teach Operation Sets does not use</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Teamcenter Integration for NX, and store the operation templates in Teamcenter</td>
<td>The correct operation subtypes</td>
<td>• Manually add the missing tool classes and operation subtypes to the generated machining rules using the Machining Knowledge Editor.</td>
</tr>
<tr>
<td>Use a library other than the native ASCII library, such as MRL or TDM</td>
<td>The tool class</td>
<td>• Replace the missing subtypes and classes. To do this:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1.  (Optional) Change your CAM configuration to use native operation types and the standard ASCII tool library.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Use Teach Operation Sets to teach the operations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Use the Machining Knowledge Editor to add or optionally replace the tool classes and the operation subtypes.</td>
</tr>
</tbody>
</table>

Fixture Planner

Product Notes

Template files

The Open dialog box displays only installed templates. You must import the standard template part files delivered with Fixture Planner into the Teamcenter database, so you can access these files in the Open dialog box. Other templates are not configured to work with Fixture Planner.

A setup script for installing Fixture Planner templates in Teamcenter is included with NX:
%UGII_BASE_DIR%\MANUFACTURING_PLANNING\templates\tcin_fixtureplanner_template_setup.bat

For information about how to use the script, see Installing File New templates in the NX help.

**Platform support**

Fixture Planner is currently supported only on the Windows platform.

**Manufacturing Additions installation**

Using Fixture Planner with Teamcenter also requires you to install the Manufacturing Additions package to Teamcenter server installation (ManufacturingAdditions 2.7). Find the ManufacturingAdditions 2.7 package in the Download or Upload Files section of the Global Technical Access Center (GTAC). ManufacturingAdditions 2.5 and later supports the Fixture Planner in NX 1872.

From the left side list of the product categories, choose Teamcenter and Teamcenter Rapid Start.

**Note:**
To proceed with downloads from GTAC, you must use your webkey credentials. Alternatively, you can also search the package in the search window. For example, search “TC11.x_ManufacturingAdditions_2.7_wntx64.zip”.

For example, you may find the Windows package at the following location:

**Teamcenter and Teamcenter Rapid Start**→
**Full Products**→
**Integrations and Solutions**→
**EasyPlan And MfgAdditions**→
**2.7**→
TC11.x_ManufacturingAdditions_2.7_wntx64.zip /
TC12.x_ManufacturingAdditions_2.7_wntx64.zip

For example, you may find the Linux package at the following location:

**Teamcenter and Teamcenter Rapid Start**→
**Full Products**→
**Integrations and Solutions**→
**EasyPlan And MfgAdditions**→
**2.7**→
TC11.x_ManufacturingAdditions_2.7_lnx64.zip /
TC12.x_ManufacturingAdditions_2.7_lnx64.zip

Find instructions for applying the Manufacturing Plant extensions in the package .zip file (Plant Extensions - Deployment Guide.pdf).
Data requirements for Export

When you export the study, it should have the data with or without NX part files. You should save the study in the Fixture Planner before the export.

Note:
You should perform Save All for the study in NX, so you can see all the required part files in the study.
Documentation Notes

Note the following about the Fixture Planner documentation:

- Fixture Planner works with BVR data structures, and the documentation describes BVR procedures wherever required.
  In the release notes, you can find Fixture Planner in the CAM section.
Caveats

Importing Fixture Data

You can make changes in the fixture assembly data in native NX and then import only the fixture assembly in managed NX. This import allows the exchange of the relevant changes within the fixture assembly, and lets you update the planning scope of Fixture Planner.

Data requirements for Import

After making changes in the fixture assembly in native NX, when you import back the changes of the fixture assembly to managed NX, the scope of the import should be the **Fixture Assembly** only, and not the study.

Line Designer

Product Notes

Template files

You must import the standard part files delivered with Line Designer into the Teamcenter database, so you can access these files in the **New Item** dialog box. If you do not perform this step, the **New Item** dialog box displays only blank templates.

A setup script for installing Line Designer templates in Teamcenter is included with NX:

```
%UGII_BASE_DIR%\MANUFACTURING_PLANNING\templates\tcin_linedesigner_template_setup.bat
```

For information about how to use the script, see *Installing File New templates* in the NX help at the following location:

Home →
Teamcenter Integration for NX →
System Setup/Administration →
Server Setup/Administration →
Installing/creating/modifying templates →
Installing File New templates

Platform support

Line Designer is currently supported only on the Windows platform.

Data Upgrade

Due to changes in the connector design in NX 11, equipment that uses connectors created before NX 11 must be upgraded to NX 11 or later format. To do this, we recommend that you open and save the equipment in NX 11 or later.
Equipment that uses connectors created in NX 11 is upgraded automatically in NX 12 or later.

For more information, see *Using library components with connectors from NX 11 or earlier* in the Line Designer caveats.

**Manufacturing Additions**

Manufacturing Additions includes Teamcenter extensions to support the following:

<table>
<thead>
<tr>
<th>4GD Support</th>
<th>Use of Line Designer with 4GD capabilities requires a Teamcenter extension called <strong>4GD Plant Design</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FactoryCAD Library Migration</td>
<td>Migrating libraries from FactoryCAD to Line Designer also requires a Teamcenter extension to support new required dataset types. This extension is included in the Manufacturing Additions package to Teamcenter installation (ManufacturingAdditions 2.7).</td>
</tr>
</tbody>
</table>

You can get the Manufacturing Additions package to support 4GD and FactoryCAD Library Migration from the Download or Upload Files section of the Global Technical Access Center (GTAC).

You can find the Manufacturing Additions Windows and Linux packages from the EasyPlan And MfgAdditions section.

**Note:**

To proceed with downloads from GTAC, you must use your webkey credentials.

Find the instructions for applying the Manufacturing Plant extensions in the package zip file (*Plant Extensions - Deployment Guide.pdf*).

**Factory resource samples**

Installation of the sample factory resources, conveyors, and robots from the manufacturing resource sample library to Teamcenter is highly recommended.

- **Factory Resources**
- **Factory Conveyors**
- **Factory Robots**
- **Factory Weld Guns**

Instructions for installing the samples are located in the following section of the Teamcenter HTML documentation:
Manufacturing Resource Library version compatibility

Line Designer supports the use of factory resources with compatible versions of Teamcenter and Manufacturing Resource Library (MRL), as shown in the following table.

<table>
<thead>
<tr>
<th>Teamcenter version</th>
<th>Manufacturing Resource Library (MRL) version</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.4</td>
<td>MRL 4.0 and 4.1</td>
</tr>
<tr>
<td>11.5</td>
<td>MRL 5.0</td>
</tr>
<tr>
<td>11.6</td>
<td>MRL 5.1</td>
</tr>
<tr>
<td>12.1</td>
<td>MRL 5.1</td>
</tr>
</tbody>
</table>

Note:
You should always upgrade the Manufacturing Resource Library components from the previous release to the new release.

Upgrading smart objects to the current NX version

NX will automatically upgrade the older version of smart objects from previous NX releases to the new version when they are opened and saved in the new version of NX.
Documentation Notes

Note the following about the Line Designer documentation:

- Line Designer can work with either BVR or 4GD data structures, and the documentation describes BVR and 4GD procedures separately wherever required.
  In the release notes, you can find Line Designer in the CAM section.
Caveats

Configured components in the Plant Navigator

Configured out components from the plant structure appear as loaded components with no graphics in the Plant Navigator.

Using library components with connectors from NX 11 or earlier

While placing or disconnecting components in a layout, or while dragging components to another layout, you may experience incorrect behavior if those components have connectors created in NX 11 or earlier.

Recommendation Before using the library objects in NX 12 or later Line Designer layouts, you should upgrade any part files of the library objects that include connectors created in NX 11 or earlier. To do this, open and save the library objects in the later version.

Editing smart components in a layout

In a layout, when you edit a floor component or a platform component from the Reuse Library, the geometry of that component disappears.

Workaround Change the reference set of that component, from Model to Entire Part.

Dragging in the Plant Navigator

In a layout, when you drag any component from the Reuse Library to a large assembly (approximately 5,000 components) in the Plant Navigator, you may observe a performance issue when you refresh the layout in NX, as the layout takes more time to load.

Note:
Drag performance from the Reuse Library is better when you zoom in the specific area of a plant, where you want to add the dragged component.

Editing component attributes in the Plant Navigator

When you load the plant layout with the Minimal Load option, you may observe that the component attributes and properties are not editable in the attribute column, in the Plant Navigator.

Loading the plant layout with connected components

While loading the plant layout with connected components, you may observe the components as disconnected in the Plant Navigator. The remedy to this issue is to restart the NX session, and again load the same plant layout.
Loading the plant layout with assembly load options

In Line Designer, while loading a layout using assembly load options, you may observe the following behavior.

**Structure Only**

When you load a shared study, NX does not support partial loading of the layout and its components in a **Structure Only** option.

**Creating occurrence poses**

When you create occurrence poses for the components, NX shows no modifications for the parent component in the tree structure, in the **Plant Navigator**. Also, if the state of the component for which you create occurrence poses is **Released**, you may observe an issue that you can still create and save the occurrence pose.

**Applying prototype poses**

When you load the plant layout with the **Minimal Load** option and you apply a prototype pose on a component, the prototype pose fails with an internal error.

**Configuring the columns in the Plant Navigator**

When you set the attribute column order for a layout in the **Column Configuration** and save it, the same column order is not reflected in the **Plant Navigator**. The remedy to this issue is to restart the NX session, and configure the columns as required.

**Sorting component in the Plant Navigator**

When you drag any component from the Reuse Library or open the component from the tree structure as **Open in Window**, NX does the automatic sorting of the components in the **Plant Navigator** tree structure. The remedy to this issue is to sort the tree structure manually to achieve the desired component order.

**Additive Manufacturing**

**Product Notes**

**Templates**

If you created your own template files in an earlier version of NX, you must do this before you upgrade to NX 1872: copy the template files from the templates folder (`%UGII_CAM_BASE_DIR%\mach\templates\`) to a separate location to prevent the installation from overriding your defined templates.
After the upgrade installation is done, copy your template files to the `%UGII_CAM_BASE_DIR%/mach\templates` location.

**New version of Build Processor Interface**

You must install the updated 3.0.1002 version of the Build Processor Interface (BPI) when you upgrade to NX 1872. You will get this message until you install the BPI 3.0.1002 version: **Incorrect version of the Materialise Build Processor Interface**.

Before you install the BPI 3.0.1002 version, uninstall the old BPI version and then install BPI 3.0.1002 from this location: `%UGII_CAM_BASE_DIR%/mach\auxiliary\mfgam\BuildProcessorInterface.exe`

You must restart your machine to complete the upgrade installation.

**Help enhancement: First Assist**

Beginning with this release, when you press F1 for help, you see initial help topics for select commands in the NX embedded browser. The web browser is available from the Resource bar, and you can double-click its tab to undock it.
With First Assist, you can:

- Learn more effectively from visual content and videos.
- See examples that will help you get started with new or unfamiliar commands, and decide which command to use.
• Link from the navigation bar to additional help topics.

• Click the feedback button and let us know what you think.

Currently, First Assist is available for the Create Supports command.
Caveats

User-defined supports

When you move a part that has user-defined supports, the part is moved; the user-defined supports move only if they reference any part geometry, like edges or faces of the part.

Heat Sink support attribute

The Heat Sink attribute is currently not visible for gusset support structures.
Documentation Notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled Hands-on: <Procedure name>.

Additive Manufacturing Process Simulation

Caveats

• The software does not yet support automatically generating compensated/deformed geometry from computed deformations, for models created with convergent geometry.

• The application will run on a localized version of NX, but the deformation results (in case of solver slicing) must be selected manually, except for the English, German or French versions.

CMM Inspection Programming

CMM release notes

PAX file change

The .pax files are now located in the UGII_BASE_DIR\cmm_inspection\templates folder.

VALISYS critical maintenance and retirement notice

The VALISYS application is unsupported as of July 21, 2016. Use the NX CMM Inspection Programming application instead of VALISYS Programming and use CMM Inspection Execution instead of NX-Inspect.

Linking to PMI information

All geometry referenced by PMI must be in the current reference set, and if it is not, then NX:

• Issues warning messages in the information window.

• May still create features, but will not create paths because there is no access to the feature geometry.
Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine simulations within the Inspection Path dialog box to fail.

Machine simulation

When you create an inspection path or simulate a program, you may see the following INI Programs message:

In order to handle INI files in the Program Manager, define the channels in the Machine Tool Builder.

You can ignore this message for NX CMM Inspection applications. It has no effect on the machine simulation.
7. Simcenter 3D

Simcenter 3D supported platforms

For information about operating system platforms supported by Simcenter 3D, see Operating system requirements.

Note:
Simcenter 3D does not support the Mac OS X.
**Pre/Post caveats**

**Selection recipes**

You can use the Filter Elements adapter to filter out elements from a selection recipe that have a particular physical property table ID or thickness value. If you change the thickness value or physical property table ID in the Element Associated Data Manager dialog box for an element, these changes will not modify the content of selection recipes that have a Filter Elements adapter defined.

Note:

If you change the thickness value or physical property table ID in the Element Associated Data dialog box or use the Modify Associated Data command, this issue does not occur.

**Suppress Hole command**

(PR 9478756) When you use the Suppress Hole command and select the Automatic option from the Creation Method list, you cannot select polygon bodies.

**Edge Separation command**

The following issues currently occur with the Edge Separation Condition command:

- (PR 9163646) If you create a 1D mesh on an edge that participates in an Edge Separation Condition, that 1D mesh may be lost during the FEM update process.

- (PR 9157743) Currently, you cannot use the Edge Separation Condition command to select a set of edges that form a closed loop. The current work around for this issue is for you to perform the operation in two steps.

**Isotropic and Anisotropic materials**

In the Isotropic Material and Anisotropic Material dialog boxes, properties on the Electromagnetic page, except for electrical Resistivity, are currently unsupported. These properties are used by electromagnetic solutions that will be available in a future release.

**Meshing**

- The 2D Mesh from Facets command is intended to be used on geometry that is highly complex and which the software cannot flatten into a 2D domain, which means that you cannot generate a mesh on it using the traditional 2D meshing techniques. There are significant limitations to the 2D Mesh from Facets command in that it does not offer the robust control that is supported by the traditional 2D Mesh command. You can use the new 2D Mesh from Facets command together with the 2D Mesh command, but there are some notable limitations.
  The 2D Mesh from Facets command:
• Does not honor the location of mesh points.

• Honors only Size on Face and Size on Edge types of mesh controls. It ignores all other types of mesh controls.

• Does not honor frozen mesh boundaries. As a result, the software:
  ■ Marks adjacent faces that you mesh with the 2D Mesh command for update when create or update a mesh with the 2D Mesh from Facets command.
  ■ Updates faces that you mesh with the 2D Mesh from Facets command before it updates faces that you mesh with the 2D Mesh command.

• Ignores Free Coincident type of mesh mating conditions.

Universal connections

• (PR 8382376) The software currently runs slowly when you change options within the Seam Weld dialog box.

• (PR 8397606) If you created a Bolt Connection in Simcenter 3D 12 and used a selection recipe with the Set of Curves option (Location tab) to define the bolt's centerline, the bolt may not be created correctly when you open the file in this release. To work around this issue, edit the Bolt Connection and redefine the Set of Curves by removing and then reselecting the selection recipe.

• (PR 8418566) In certain situations, when you start the Assembly Composer Automation process from the NVH Assembly Composer application window, an assertion appears with the following text: "Renaming part to its old name, did you really mean to do this?". If this occurs, confirm the error by clicking OK. Because this type of error may affect further work in your current session, you should allow the process to complete, save your work, and then exit and restart Simcenter 3D.

• (PR 9495739) The Assembly Composer Automation process creates the universal bolt connections with incorrect location coordinates. All the coordinates values defined for the bolts are erroneously multiplied by 1000.

• (PR 9468704) Currently, you cannot launch the NVH Assembly Composer and Assembly Composer Automation processes.

• (ER 8415220) Currently, the extended master connection file (xMCF) format that the software exports is not fully compliant with the industry standard file format. The standard specifies that a connection group should contain all the involved connections. The current functionality writes each connection as a separate connection group entry.

Delete Unreferenced Entities command

In the Simulation file, the Delete Unreferenced Entities command is currently available in the user interface but does not yet work. While you can use the Delete Unreferenced Entities dialog box to
select unused entities to delete, for example, when you click **OK** or **Apply**, the software currently issues an error message.

### Scenario-based post-processing

- When you post-process an ANSYS or Samcef file that contains engineering strain through the **Scenario Based Data-Visualization Navigator**, the software converts the engineering strain data to tensorial strain and plots the data as tensorial strain.

- (PR 8417999): When you post-process an *.lms file through the **Scenario Based Data-Visualization Navigator**, a message may display that states that the file does not contain any usable data. To work around this issue, restart Simcenter 3D and load the *.lms file in a load recipe or in an alternate representation. After this operation, you can post-process the *.lms file through the **Scenario Based Data-Visualization Navigator**.

### Simcenter Nastran FEM Acoustics and Simcenter 3D Acoustics BEM

- (PR 8409135) When **Simcenter 3D Acoustics BEM** is the specified solver, **Indirect Acoustic** is the specified analysis type, and the **Indirect Acoustic Model Formulation** option is set to **Fast Multipole** or **H-Matrix**, and the solution includes one-way, weak coupling, the software does not store vibrations in the results (displacement, velocities, or accelerations) when you request the output in SORT2 format.

- (PR 9426475 and PR 8413414) The sum of each panel's contribution to acoustic pressure does not match the total acoustic pressure in solutions when **Simcenter 3D Acoustics Transient BEM** is the specified solver or when **Simcenter 3D Acoustics BEM** is the specified solver, **Indirect Acoustic** or **Indirect Vibro-Acoustic** is the specified analysis type, and the **Indirect Acoustic Model Formulation** option is set to **Fast Multipole** or **H-Matrix**. This issue occurs when some of the nodes in the structural mesh are included in of two or more **Panel** simulation objects.

- (PR 7936548 and PR 8414353) The Simcenter Nastran FEM Acoustics and Simcenter 3D Acoustics BEM solvers do not allow the file names or paths that contain spaces, special characters, or very long file names. If you encounter issues, try shortening the file or path name or removing any spaces or special characters.

- (PR 9504633) An issue occurs when you export displacement, acceleration, or velocity loads from Simcenter HDF5 (.sc_h5) files that you create with the **Enforced Motion from External File** command to Simcenter Nastran. The software exports these loads as **SPCF** bulk data entries. Because the **SPCF** bulk data entry requires a companion **SPC** entry, the software also creates and **SPC** entry during the export process. Currently the software erroneously creates the companion **SPC** entry with both rotational constraints as well as translational constraints (123456), even though the **SPC** entry should only have translational constraints (123). To work around this issue, you can manually edit the exported file and delete the rotational constraints (456) from the **SPC** bulk data entry.

- (PR 8419013) The **Import LMS Virtual.Lab XML Model** command does not yet support the import of specific duct modes with function data and distributed duct modes with constant data.
Specialist Durability

Simcenter 3D Specialist Durability currently has the following limitations and known issues:

• Currently, in the Computation Location dialog box, you can select the Nodes of Elements and Center of Element options in the Result Output Location list only if the stresses are available on elements or nodes of elements. The software currently cannot convert nodal stresses to element stresses.

• For ANSYS .rst results, currently only the standard stress and strain calculations are supported. Seam and spot weld calculations do not work yet.

• For ABAQUS .obd results, force-based spot weld and force-based seam weld solutions are not yet supported.

• Currently, error messages that occur because the solution is not set up correctly do not provide information on how to correct the problem.

• Currently, you cannot define Function Definition Locations using node and element IDs.

• When you use the Analysis Type Manager to edit Analysis Types that are define in local user libraries, you cannot persistently add new Durability Simulation Objects since the objects are not defined in any library, the addition does not persist. The same issue also occurs with Solver Profiles and their Solver Parameters. To work around this issue, define the new Durability Simulation Objects or Solver Parameters in a local library before you edit the Analysis Type or Solver Profile.

• The Results Table shows only the first event of a duty cycle.

• For the Haibach/Miner simulation object that is stored as a library parameter, the slope coefficient is currently set to a value of 3 instead of a value of 1, which is the correct default value. To work around this issue, use the Simulation Object option in the Simulation Navigator to create a new Damage Accumulation object. Set the Accumulation Type to Haibach-Miner and set the Haibach-Miner Slope Coefficient value to 1.

• When you post process the cyclic fatigue damage results of multiple duty cycle load events, the software does not always correctly calculate the accumulated results value. To work around this issue, you should check the results of the individual events to validate whether the accumulated result value is correct.

• A function definition location that uses strain gages can process gages defined on nodes or gages defined on elements, but not both together: In that case, you must use the Function Definition command to define two function definitions.

• When you use the Create Material command and use the uniform material method, the results are incorrect if the Fatigue Strength properties of the source material are defined with a slope field. To work around this issue, create a copy of the source material and either delete its fatigue strength data or change its type to Expression.
• For seam welds and spot welds:
  
  • Seam welds are supported for 2D meshes only.

  • Stress-based spot welds that have only spider elements at the weld location and no 2D elements are not currently supported

  • When you define seam welds, if the weld begins in a location where the orientation of the 2D elements is very different from the rest of the seam weld, the software may not handle the side information as expected.

  • When you use force-based seam welds, Specialist Durability handles the correct fine matrix for seam welds more strictly than LMS Virtual.Lab Durability. Therefore, Simcenter 3D Specialist Durability may sometimes not detect all the matrices that LMS Virtual.Lab Durability detects.

  • In the Seam Weld Connection universal connection dialog box, if you use a vector to define the Location of the connection (Weld Properties page), the Specialist Durability solver may fail to start. To avoid this issue, select one of the flange/side options, such as Flange 1, Side 1, to define the location.

  • Selecting the top Element Result Location when you process seam weld results in a 3D Specialist Durability Scenario may exclude elements on the base sheet.

  • In the Notch Stress Configuration dialog box, the Best Fit option in the Geometry Definition list does not currently work.

Laminate Composites

• A graphics issue associated with the Sketcher group in the Laminate Modeler, Solid Laminate Modeler, and View Laminate dialog boxes can affect the Simcenter 3D graphics and memory management, making the product unstable. For laminates applications, it is recommended to use Simcenter 3D 2019.2 version 1876.

FE Model Correlation: Pre-test

• When you clone a pre-test solution process in which candidate or required node DOFs are defined using the Use Normal DOF check box, results for the normal DOF nodes are ignored in the cloned pre-test solution process.

• Pre-test exciter configurations do not correctly process node DOFs that are defined using the Use Normal DOF check box. Only sensor configurations process normal DOFs correctly.

• In a pre-test solution process with a solved configuration, if either candidate or required DOFs point to a DOF set that contains a selection recipe, updating the selection recipe does not cause the configuration status to become out-of-date.
• The status of pre-test sensor configurations erroneously depends on exciter sensor and candidate DOFs. For example, if you clear the exciter candidate DOFs, a solved sensor configuration status becomes out-of-date.

FE Model Correlation

• In version 2019.1 of the Mode Pairing dialog box, there was a spurious relationship between the Frequency Tolerance (%), Frequency Tolerance (Hz), and the Track Mode Pairs check box settings. This erroneous behavior has been fixed in version 2019.2, however migrating a 2019.1 model to 2019.2 may give unexpected Frequency Tolerance and Track Mode Pairs settings.

• When there are more sensors than there are nodes in a FEM mesh at a given location, some of the sensors may not be mapped. This is an unusual situation as there are generally more FEM nodes than there are sensors, however it is possible especially with laser measurements.

• Resetting a Test Model alignment in a Simulation that was migrated from an earlier version of Simcenter 3D results in an incorrect initial position.

• An intermittent units issue causes nodes of analysis reference solutions created from solutions not using Simulation units (for example, in N-M instead of the Simulation units of mN-mm) to be improperly scaled, resulting in a mapping failure with the work solution nodes.

FE Model Update

• The genetic algorithm results are not repeatable, as there is no seed to define identical starting parameters.

• When you update the finite element model, some physical properties are updated in the Simulation file instead of the FEM.

Thermal/Flow, Electronic Systems Cooling, Space Systems Thermal, Multiphysics

Immersed boundary method

• Only a single fluid material is allowed in the model. Multiple enclosures with separate fluid materials are not supported.

• It is not possible to use deactivation sets to remove a portion of the IBM meshes from the simulation. The entirety of all three meshes generated using the 3D Immersed Boundary Mesh command (TET, PYR, HEX) must be included in the simulation.

Editing the attributes of multiple PCB layers and vias

• When you edit multiple PCB Layer modeling objects, and set Thermal Conductivity to Specify, the Thermal Conductivity Override property always displays the red square icon, which indicates different values, even if values are the same for all the selected PCB layers.
• Incorrect and unexpected behavior for the Trace Coverage and Via Coverage when you edit multiple PCB Layer and PCB Via modeling objects: if you change the value of the trace or via coverage, then selects No Change, the value does not go back to the original value, and if you click OK, one of the selected PCB layers or vias will have the trace or via coverage value changed.

Protective Layers simulation object

• If you apply a Protective Layers simulation object with two layers to your model, then in the Post Processing Navigator, under the Temperatures Protective Layer Bottom Face – Elemental, Temperatures Protective Layer Middle – Elemental, and Temperatures Protective Layer Top Face – Elemental nodes, you access the temperatures of the two layers through the Top and Bottom shell selections in Post View, instead of the Ply 1 and Ply 2 nodes.

Primitives

• When you have primitives in your model that you export to a TSS file, and the primitives are of the type that requires angular specification (such as a sphere or a cone), and you import the TSS file again into the software, incorrect primitives are imported.

• When you use the Menu→Insert→Primitive commands, primitive types that require angular inputs may not be working correctly. Consider using the Mesh Primitives commands instead.

Abaqus environment

Beginning in this release, Pre/Post supports the import of node and element definitions from Abaqus .odb files. Currently:

• Pre/Post does not correctly import a mesh that was originally defined as rigid link coupling connection in the Abaqus environment in Pre/Post. The rigid link coupling connection mesh is defined by a group of nodes with the *KINEMATIC COUPLING keyword using the Automatic Coupling command. Pre/Post imports the nodes from the .odb file, but it does not currently import the rigid link defined by the *KINEMATIC COUPLING keyword.

• If the .odb file was generated from an assembly model, Pre/Post imports only a flattened model. The software offsets the node and element labels in the imported model to new label values and reports this change in the .lis file during the import process. However, the software does not apply this change in node and element labels to results data. Because of this potential difference in labels, querying result data by node and element label after import may not work.

LS-DYNA environment

When you import an LS-DYNA input file, the software does not import the material orientation for the *ELEMENT_TSHELL_COMPOSITE keyword when the first ply material keyword has a negative AOPT parameter, which means that its absolute value is Material Orientation Coordinate System Label. After the import, only the first element in the mesh collector has a defined Material Orientation value. Other elements do not have Material Orientation value, and the software places them into a different element collector.
Simcenter Samcef environment

(PR 8394509) The **Solid Properties Check** command does not work on composite elements.

(PR 9469076) The **Friction Stiffness (STFR)** parameter in the **Contact Parameters** dialog box shows wrong force/length unit while pressure/length unit is expected.

- The following issues currently occur when you import a Samcef model into Simcenter 3D:
  - Simcenter Samcef does not import Samcef .MCE elements in which element axes are defined by \( \mathbf{V}_{ij} \) direction coefficients instead of standard \( \mathbf{FRAME} \) coordinate system: these elements are rejected in the **User Defined Text** epilog.

- The following issues currently occur when you export a model from the Simcenter Samcef environment:
  - The software does not export beam element offsets that are defined using **Element Associated Data**.
  - In subcases of a **Nonlinear** solution, you cannot enable or disable a **Surface-To-Surface Contact** simulation object if this contact is a bidirectional one.

Model and Load Pre-Processing solution process

The **Model and Load Pre-Processing** is a new solution process in this release and currently has the following limitations:

- (PR 8377726) Scenarios that include mesh mapping, FFT transformation, and other options are only supported on Windows platforms.

- (PR 8379623) You cannot use Test.Lab (.LMS) files to define loads, such as accelerations.

- (PR 9179430) You should use MKS units only. You must use the **Advanced Solver Options** dialog box to set the unit system to (N)(m)(kg) when you solve Nastran solutions.

- (PR 9175937, PR 8378759) Journaling is not currently supported.

- (PR 8381974) The process monitor window and the log files do not update during the solution. The software currently displays all messages when the solve completes.

- (PR 9197259) **Time to Waterfall of Time Data** results are shifted by one time step compared to Virtual.Lab results.

- Performance issues currently occur when loading (PR 8380431) and unloading (PR 8380589) intermediate meshes, using the **Time to Waterfall of Time Data** command (PR 9191828, PR
8380901), performing FFT operations (PR 8380901), and when you edit large CGNS files (PR 8380633).

**Margin of Safety**

- The following *Margin of Safety* features are currently available in English only:
  - The Simcenter 3D Aerostructures Standard Methods documentation that is available in Simcenter 3D and accessible when you create an aero calculation.
  - The calculation method input parameter names and the output type names.
- (PR 9502660) You may encounter performance issues working in the *Simulation Navigator* when the *Margin of Safety* solution process contains hundreds of calculations.
- (PR 8418611) If you create a *Calculation* that uses input data from an external file, the software may not be able to retrieve that data when you solve the solution. This can cause the solution to fail. Currently, you if create a *Calculation* that uses data from an external file, save the solution, exit the software, and then relaunch the software to solve this solution, the solve fails.

**Flexible Pipe**

- While you can undo the creation of Flexible Pipe features, you cannot redo them.
- To access a subpanel from a tree item in any definition panel, you must double-click the item rather than press the *Enter* key. To close a subpanel of a definition panel, you must click the *OK* or *Cancel* button. You cannot press the *Enter* key to close a subpanel.
- (PR 8560541) Currently, you cannot generate a report of a computed assembly that contains bundles with supports.
- When you select the *Disable caches* setting, the software cannot compute the assemblies.
- (PR 8560671) The yellow spline that symbolizes a pipe does not update correctly when you modify pipe geometrical inputs.
- You cannot save pipe or assembly strategy from the *Information* window and directly reuse it as a user strategy unless you change the saved file format to ANSI before you save the information.
- (PR 8560676) You cannot preview pipes when the supports are too close to each other.

**Additive Manufacturing Process Simulation**

- When you set the *Mode* option in the *Mechanical Slicing* dialog box to *Solver*, and you are running this application on a localized language version of Simcenter 3D that is not English, French, or German, the software cannot automatically open the *Post Processing Navigator* and select and...
display a result at a particular time step. To work around this issue, you must manually open the Post Processing Navigator and browse to the results that you want to display.

- You cannot use Additive Manufacturing Process Simulation to analyze an additive manufacturing part that has components that contain multiple bodies.

- Compensation is the process of using the results from an Additive Manufacturing Process Simulation analysis to create a pre-deformed additive manufacturing part that it suitable for printing.

- You cannot automatically generate compensated/deformed geometry from computed deformations for models created with convergent geometry.

- When you compensate a patterned part, the software only compensates the first occurrence of the part.
Motion caveats

The following issues currently exist in Motion.

Road visualization

If you enable visualization for an RSM2000 file and use a small grid density (such as 10 mm), you might experience performance issues.

Flexible bodies

(PR9326221) Normal modes in Abaqus files generated with Simcenter 3D are not used by flexible bodies.

(PR 8417601) On Linux, you cannot use the Simcenter 3D Motion Definition File Toolkit to solve models with flexible bodies.

Teamcenter Integration and Motion

You cannot upload external files to Teamcenter when you import a motion part that was created before Simcenter 3D Motion 2019.1. To work around this issue, open a previous version motion part in the current version of Simcenter 3D and save it. Then, import the saved motion part to Teamcenter.

Virtual.Lab-to-Motion translation

Units are not preserved when translating math functions that refer to expressions, other math functions, or profile elements. To work around this issue, use a consistent unit set for all data definitions to avoid unit conversion issues. In addition, when translating an LMS Virtual.Lab Motion model using the migration tool (VL2SCMigrationTool.exe), expressions are translated into math functions. To improve consistency, the migration tool always migrates spline curves to profiles instead of a combination of profiles and AFU tables.

Solver expressions (math functions) that reference Amesim watch variables using eval_control_node are not translated correctly.

Simcenter 3D Motion-TWR

(PR9437707) Some session data is not saved to Motion after closing Simcenter 3D Motion-TWR. For example, plots may not be recovered and out-of-date statuses on test rigs may not be saved.

All coordinate systems that are to be used with Simcenter 3D Motion-TWR must reside in the Simulation file, not in part files.

Submechanisms are not supported.
Simcenter 3D Motion-TWR may take a long time to open when using a node-locked license. To work around this issue, use a value-based license.

The Adaptive Modeling feature is not working correctly.

**Simcenter 3D Motion Transmission Builder**

Simcenter 3D Motion Transmission Builder does not display a warning message when you close it without saving the configuration.

In the FE Preprocessor, the number of the pinion cutter teeth for ring gear geometry generation is internally defined as half the number of teeth on the ring gear. This may cause a geometry creation error for some ring gear geometries (for example, pointy tooth shape).

**Simcenter 3D Motion Real-Time Export**

When creating a Simcenter 3D mechatronics element for export to a real-time platform, the gain and bias values are always set to one and zero, respectively. To work around this issue, use other control elements to scale values going in to the mechatronics. This restriction is only for real-time solutions. The gain and bias values work as expected in standard solutions.

**General**

(PR9182872, PR9180895) The mass calculation functionality is providing different inertia directions on body occurrences. This is a numerical tolerance issue and only happens in simple symmetric models, such as a cube.

(PR8380201, PR9170607) Marker position is reported as marker's initial position transformed with rigid body transformation. The flex body transformation is not considered.

(PR9480505) When using Amesim prior to version 2019, you must manually set the VLMOTIONSLV environment variable. In addition, the `Cosim_setup.bat` file sets TECWAREHOME to the incorrect folder. This affects all Amesim and Matlab export scenarios where the mechanism uses time series input and output elements. To work around this issue, edit the generated launchers and set the environment variable to `%UGII_BASE_DIR%\simulation\tecwarelib`.

(PR9499532) Simcenter 3D Motion crashes when you delete a joint that is referenced by a joint driver and whose icon is displayed in the graphics window.

(PR9290120) Simcenter 3D Motion crashes when you delete a profile that is referenced by flexible damping factor.

(PR9373903) When measuring the reaction force of a revolute joint, you cannot solve the model if you use a force sensor function in an expression and enable friction on the revolute joint. To work around the issue, insert a dummy body at the location of the revolute joint and then set up a generic force sensor to measure the loads at the axis system of the fixed (bracket) joint of the dummy body. Note that
this workaround will produce different results if performed on force sensors migrated from LMS Virtual.Lab.

In the documentation, the "Solving a mechanism using the Simcenter 3D Motion Definition File Toolkit" topic contains an incorrect note. It should say, "You cannot use the toolkit to solve a model that contains higher-pair constraints."
Simcenter Nastran 2019.2 caveats

Simcenter Nastran - General issues

• (PR 9457614) Possible error or incorrect results when Intel MKL Pardiso solver is used in SOL 108 frequency dependent analyses, via system (555)=3.

• (PR 9455727) Use of DMP and Intel MKL Pardiso may result in silent crash. If Pardiso is used in SOL 108 and SOL 111 analyses along with DMP keyword, it results a crash. The workaround is to use the sparse solver (which is the default option) in the FRRD module.

• (PR 9429843) Use of RIGID = LAGRANGE with the VKI or CASI Element Iterative solvers for thermal expansion analysis in SOL 101 may produce wrong result if the model also contains MPC. This is a bug from Nastran 6.0. Workaround is to use sparse solver if the user is interested in considering thermal expansion of rigid elements in the model.

• (PR 9499927) In SOL 108 analyses, AUTOSPRT is on by default. This can mask modeling issues and lengthen run-times. The workaround is to use PARAM, AUTOSPRT, NO.

• (PR 9477713) Use of DMP for SRSS analysis can give incorrect results. The workaround is to use SMP instead of DMP in order to speed computations.

• (PR 9455516) In SOL 110 synchronous rotor dynamics analyses, complex eigenvalue results output is incorrect. Eigenvalue entries in the Campbell-diagram, however, are correct.

Simcenter Nastran - Vibroacoustic analysis issues

• (PR 9296546) Strongly coupled vibroacoustic analysis in SOL 108 using HFEM with ACPRESS and MATPOR entries produces incorrect results. Note that analysis with ACPRESS entry or MATPOR entry alone produce correct results.

• (PR 9288305) Direct Complex Eigenvalues (SOL 107) analysis with acoustic absorber may hang in eigensolver. A workaround is to use the ISRR method instead of default CLAN.

• (PR 9497559) Incorrect answers with SDAMPING (structure) in SOL 108 strong-coupling and adaptive order (FEMAO). The workaround is use Sol 108 weak coupling or Sol 108 HFEM (both strong and weak).

• (PR 9464248) SOL111 ATV response using RDMODES gives incorrect microphone pressure results depending on DISPLACEMENT output request. A workaround is to add PARAM, RDSPARSE, NO in bulk data.

Simcenter Nastran - Design Optimization issues

• (PR 8418969) In SOL 200 topology optimization, convergence issues might occur when defining the objective with DESOBJ (MIN, SCFUNC=MAX, ENFUNC=MAX) or DESOBJ (MAX, SCFUNC=MIN, ENFUNC=MAX).
ENFUNC=MIN) and there are more than 100 actual constraints in the job (such that SDO is selected as optimizer). A workaround consists in forcing the use of SDO optimizer by setting system cell 425 to 1.

- (PR 8418968) In SOL 200, when defining the objective with DESOBJ (MIN, SCFUNC=MAX, ENFUNC=MAX) or DESOBJ (MAX, SCFUNC=MIN, ENFUNC=MIN). Incorrect objective is written into csv file, instead of actual objective. Actual objective is correctly written into f06 file.

Simcenter Nastran - Solution 402

- (PRs 8418069 + 9475942) In SOL402, when using a hyper-elastic material MATHE (all types) with a small value of the compressibility ratio K (corresponding to a Poisson ratio smaller than 0.499), incorrect results and/or bad performance could be obtained, especially with very large deformation. This was due to an error in the treatment of the incompressibility. There is no workaround except increasing the compressibility ratio to a large value.

- (PR 8417583) In SOL402, when using a hyper-elastic material (MATHE or MATHP) with PARAM LGSTRN turned on, the Von Mises stresses available as output is computed using the PK2 stress measure, while the tensor is computed using the Cauchy stress measure. As a workaround, the Von Mises stress can be recomputed using the tensor values.

- (PR 8417153) In SOL402, when performing a modal analysis without any pre-stress with a temperature-dependent material, the material properties were evaluated at 0 degree instead of TEMP(INIT). As a workaround, the user can add a first static subcase before the modal subcase.

- (PR 9451103) When performing a restart in SOL402, the output results of the subcases of the initial run that were removed in the restart run were still visible in the restart run. For example, if the initial run contained 2 subcases (1 and 2) and the restart run added a third one to be executed (EXEFROM=3) but restarted from the first one (RSTFROM=1), results from subcase 2 were incorrectly copied to the final post-processing file of the restart run but should have been deleted.

- (PR 9431951) In SOL402, if the model contained a large amount of boundary conditions or subcases, the translation of those load could sometimes be very time consuming, without leading to incorrect results. This will be fixed in a future release.

- (PR 9487561) In SOL402, when a DTEMP case control card is defined and the analysis type of the first subcase is different from STATICS, DYNAMICS and PRELOAD, the temperatures are not applied. As a workaround, the user can change the order of the subcases to prevent the described occurrence. Another possibility is to add a dummy STATICS subcase with no loads and a constant temperature as first subcase.

- (PR 9475934) In SOL402, when a DTEMP bulk card refers to both TEMP and TEMPD bulk cards, the temperatures which are applied to the nodes not defined in the TEMP cards are wrong. As a workaround, the user can replace the TEMPD cards by equivalent TEMP cards.

- (PR 9474437) In SOL402, when a MODAL subcase is followed by a STATICS subcase in which the temperatures are stepped (NLCTL2 TVAR=STEP) and not ramped, the material parameters for the modal analysis are evaluated at the TEMP(LOAD) temperature rather than the TEMP(INIT). This only impacts the eigenvalues but not the eigenvectors.
• (PR 9473563) In SOL 402, when a model contains PLOAD cards, the pressure loads are incorrectly evaluated, which causing wrong results. In the next release, PLOAD will not be allowed anymore and should be replaced by PLOAD4.

• (PR 9472658) In SOL 402, when both case control cards TEMP(INIT) and TEMP(LOAD) are defined and refer to different temperature IDs, for example:

\[
\text{TEMP (INIT)} = n_1 \\
\text{TEMP (LOAD)} = n_2
\]

and the first set identification number (n1) refers to TEMP bulk cards, while the second set identification number (n2) refers to both TEMP and TEMPD bulk cards, the temperatures defined by the TEMPD cards are not applied on the involved nodes. As a workaround, the user can replace the TEMPD cards by equivalent TEMP cards.

• (PR 8416427) In SOL 402, when a model contains more than one subcase, including more than one preload subcases but no statics or dynamics subcases, the mechanical or thermal loads might not be evaluated correctly, leading to wrong results. For instance, in case of prescribed temperatures, a wrong initial temperature is applied. As a workaround, the user can add at least one statics or dynamics subcase.

• (PR 9464705) In SOL 402, when performing a restart solution on a model containing kinematic joints, the restart solution might not converge. Rerunning the whole solution from the beginning can solve the issue.

• (PR 9461039) In SOL 402, when a load card is referenced by both a LOAD card and a DLOAD case control card in the same subcase, the input associated to the time-unassigned load (LOAD) is ignored, which causes wrong results. As a workaround, the user can duplicate the loading cards with a different identification number, the latter being referenced either by the LOAD card or the DLOAD card or use only one of the 2 methods (LOAD or DLOAD).

• (PR 9448606) In SOL 402, when DTEMPEX and TEMPD bulk cards have the same identification number, the computation fails due to an out-of-bounds array access. As a workaround, the user can use DTEMP cards instead of DTEMPEX cards.

• (PR 8410791) In SOL 402, when enforced displacements along the three directions are applied on the master node of a RBE2 element attached to a CPLSTN4 element, two displacements are not taken into account.

• (PR 9472097) In a SOL 402 with contact BCTSET, if the user wants to disable the friction regularization by writing BCTPAR2 STFR 0., the solver will use a zero value for the regularization stiffness instead of ignoring this parameter, causing convergence problems. As a workaround, the user can simply enter a large value (e.g., 100 times the Young modulus).

Simcenter Nastran - Solution 401
• (PR9492104) For 4 noded element faces in a region referenced by PLOADFP, only 3 out of the 4 nodes show the fluid penetration pressure value. The 4th node shows a 0.0 which is incorrect. The pressure is applied correctly, and this is just an output issue. The fluid penetration can still be observed based on the nodal values for the 3 nodes.

• Composite elements referenced using PLOADFP will not produce correct results.
Finding software field bulletins (SFBs)

You can find all software field bulletins (SFBs) for a given release using the following page:

8. Knowledge Fusion and DesignLogic functions

Product Notes

Impact of angle base units on custom Knowledge Fusion and DesignLogic functions:

Customers who use NX interactively should see no impact from this change. Customers automating NX programmatically should read this section carefully.

The internal base units for angles are now radians instead of degrees. Internally, calculations involving angles will be converted to radians while the calculation is performed. This change enables certain new calculations involving angular units. This affects not just the angle measurements but every measurement that includes angular dimensions as shown in the following table.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Base units before radian-based</th>
<th>Base units in radian-based</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>degrees</td>
<td>radians</td>
</tr>
<tr>
<td>Angular Velocity</td>
<td>degrees/sec</td>
<td>radians/sec</td>
</tr>
<tr>
<td>Angular Acceleration</td>
<td>degrees/sec^2</td>
<td>radians/sec^2</td>
</tr>
<tr>
<td>Angular Jerk</td>
<td>degrees/sec^3</td>
<td>radians/sec^3</td>
</tr>
<tr>
<td>Per Angle</td>
<td>1/degree</td>
<td>1/rad</td>
</tr>
<tr>
<td>Angular Momentum per Angle</td>
<td>mN-mm-sec/degree</td>
<td>mN-mm-sec/rad</td>
</tr>
<tr>
<td>Moment per Angle</td>
<td>mN-mm/degree</td>
<td>mN-mm/rad</td>
</tr>
<tr>
<td>Voltage per Angular Velocity</td>
<td>microV-sec/degrees</td>
<td>microV-sec/radians</td>
</tr>
<tr>
<td>Length per Angle</td>
<td>mm/deg</td>
<td>mm/rad</td>
</tr>
<tr>
<td>Per Angle Squared</td>
<td>1/degree^2</td>
<td>1/rad^2</td>
</tr>
<tr>
<td>Mass Moment of Inertia Per Angle</td>
<td>kg-mm^2/deg</td>
<td>kg-mm^2/rad</td>
</tr>
</tbody>
</table>

Custom DesignLogic and Knowledge Fusion functions with parameters involving angular dimensionalities may need to be scrutinized for accuracy.

- Functions that have been authored using pure KF language may not be impacted. Any special coding done by the you to handle units/unit conversions in your functions should work in the same way as 1847.

- Functions that make calls to UG Open/Ufunc accepting and returning dimensionalities with angles may be impacted. Even those that don’t may be impacted.
For example, the functions floor() and ceiling() had to be changed because they sometimes may receive a value that has an angle dimension, in which case UF_KF_ask_number() would return a radian value.

You might have special custom coding to apply unit conversion from degrees to radians in such cases which may no longer be necessary. We also recommend looking into the APIs UF_KF_ask_number_with_measure & UF_KF_make_number_with_measure that provide numbers in degrees while preserving the dimensionality. Using these APIs instead of UF_KF_ask_number & UF_KF_make_number may help achieving the original intent of the KF/DL functions. For example:

```c
//========================================
DllExport extern void supplementary_Angle(UF_KF_value_p_t *data, int num, UF_KF_value_p_t *rv)
{

    //Initialize UF session
    UF_initialize();
    double angle=0;
    char *dim = "";

    // Extract a degree-based value and its dimensionality from an input argument
    UF_KF_ask_number_with_measure(data[0], &angle, &dim);

    //Calculate supplementary
    double comp = 180 - angle;

    // Prepare a return value with a given dimensionality.
    UF_KF_make_number_with_measure(comp, dim, rv);

    UF_terminate();
}
```
9. Validation

Check-Mate and Requirements Validation

Caveats

Validation rules

Validation rules do not recognize unset part attributes.

Using NX Issue Management

To use NX Issue Management, Teamcenter Issue Manager must be deployed from the server by the Teamcenter Environment Manager. If NX cannot connect to Teamcenter Issue Manager, you will see a message. For more information, see the Teamcenter Environment Manager help.

Using Teamcenter for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed by Teamcenter Environment Manager on the server side.
10. Tooling Design

Tooling Design documentation notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download, which let you work through detailed instructions on your own. These hands-on procedures are a good learning tool to try out new functionality and complex workflows. The procedure topics are titled Hands-on: <Procedure name>.

Press Die Checker

Product Notes

Platform support

Press Die Checker is currently supported only on the Windows platform.

OmniCAD

Product Notes

OmniCAD

Starting with NX12.0.1, you are no longer required to run the InstallSentinel.bat file to run commands in the OmniCAD for NX application.

Mold Wizard

Optimized settings for MW Part Family Library

There are several recommended settings to improve the performance of your session of Mold Wizard. These settings are located within the Customer Defaults, Visualization Preferences, and Selection Preferences dialog boxes. You can double-click MW_Setting.vb located in the MW Part Family Library to automatically set the following:

Customer Defaults

- Disable missing interpart warnings.
- Disable material to avoid material part attribute conflicts.
- Set the pocket color to match the tool body color when you create new geometry.
• Disable creating part and model view preview images at any time during the design.
• Disable **Update Reading Direction after View Rotate** for PMI.
• Enable double-clicking a feature to edit its parameters.
• Enable **Apply Changes to Owning Part** when editing an object's display parameters.
• Treat a **Degree 1** spline as a polyline.

**Visualization Preferences**

• Enable session translucency.
• Disable emphasis precedence for the work part.

**Selection Preferences**

• Disable **Highlight Selection on Rollover**.

**Progressive Die Wizard**

**Optimized settings for PDW Part Family Library**

There are several recommended settings to improve the performance of your session of Progressive Die Wizard. These settings are located within the **Customer Defaults**, **Visualization Preferences**, and **Selection Preferences** dialog boxes. You can double-click **PDW_Setting.vb** located in the **PDW Part Family Library** to automatically set the following:

**Customer Defaults**

• Disable missing interpart warnings.
• Disable material to avoid material part attribute conflicts.
• Set the pocket color to match the tool body color when you create new geometry.
• Disable creating part and model view preview images at any time during the design.
• Disable **Update Reading Direction after View Rotate** for PMI.
• Enable double-clicking a feature to edit its parameters.
• Enable **Apply Changes to Owning Part** when editing an object's display parameters.
• Treat a **Degree 1** spline as a polyline.

**Visualization Preferences**

• Enable session translucency.
• Disable emphasis precedence for the work part.

**Selection Preferences**

• Disable **Highlight Selection on Rollover**.
11. Data translation

Product Notes

Updates in the default tessUG.config JT configuration file

The `doSectionViews` configuration option which is used to process non-lightweight PMI section views (also known as heavyweight section views) is removed from the default `tessUG.config` file shipped with NX11. This option is now renamed as `LegacyHeavyweightSectionViews`. If your existing NX part or assembly contains section views created using PMI tab→Section View command in Pre-NX11 versions and you want to translate these section views to a JT file, you need to add `LegacyHeavyweightSectionViews` option in your `tessUG.config` configuration file and set it to true.

CATIA V5 translator product notes

You can now import the following type of files to NX:

- CATIA V5-6R2018 SP3 files
- CATShape files
- CGR files

You can now set Include Reference Geometry as a translator option.

ACIS translator product notes

You can now read and write ACIS version up to R28.

DXF/DWG translator product notes

You can now read and write AutoCAD DXF/DWG version up to 2019.

NX to JT translator product notes

NX to JT translator now supports the IRAY texture material translation to the JT file.

NX ProE translator product notes

You can now import Creo5.0 files to NX.
**Caveats**

**Internationalization caveat**

File import or export by the following translators may not work if you set the NX temporary directory `UGII_TMP_DIR` to a folder containing non-locale characters.

- DXF/DWG
- IGES
- STEP
- 2D Exchange (export only)

**NX to JT translator caveats**

**NX to JT translator caveat for the Windows operating system**

If you are translating pre-NX11 parts with material, texture, and light applied on it and you want to get the texture or light information into the JT file, We recommend you to invoke NX in Author2 (non-IRAY+) rendering mode and then translate the parts to a JT file. This recommendation is applicable for JT creation from interactive NX session as well as command line application `ugtopv`. Contact GTAC to get more information on how to invoke NX in Author2 (non-IRAY+) rendering mode.

**Note:**

If you invoke NX in Author2 (non-IRAY+) rendering mode then these options will be available in the JT Configuration and the Export JT dialog boxes.

**NX to JT - IRAY texture and material caveats**

In some situations, you may find differences between the quality of the texture displayed in NX and that displayed in JT, when you view it in the Teamcenter Visualization.

**DXF/DWG translator caveats**

File $\rightarrow$ Export $\rightarrow$ DXF/DWG does not work in NX manager.

**DXF/DWG — Dimension export caveats**

These caveats are applicable when you export a file using the 3D option in the AutoCAD DXF/DWG Export Wizard dialog box.

- Dimensions associated with external references are exported as non-associative dimensions to the DXF/DWG file.
• NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block reference.

• The dimension associated between NX sheet object and View port object may be translated as overridden text of AutoCAD dimension.

• Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.

• Chamfer and Thickness dimensions are exported as block reference to the DXF/DWG file.

• Angular dimensions created with vector option are exported as block reference to the DXF/DWG file.

• Dimension with fits tolerance having fit tolerance style other than **Fit Symbol** is exported as block reference in AutoCAD.

• Dimension text location may not match with NX for the dimensions created with oriented text.

• Dimension line breaks and foreshortening symbols are not supported when dimension is exported as group or block.

• If a dimension text is on the extended dimension line, the exported dimension has to be updated to view any foreshortening symbols on it.

**DXF/DWG — MText import caveats**

You cannot import:

• MText paragraph tabs to NX.

• Euro symbol (created using %%128 in MText) to NX.

**DXF/DWG — Architecture data import caveats**

• You can not import:

  • View dependent data

  • Texture data

  • Corner windows

  • Wall cleanups

  • Body modifiers on staircase

• Associativity defined between the architecture objects is not maintained in NX. For example, door on wall will not move along if wall is moved.
DXF/DWG — Solids import caveats

You cannot import:

- Material, color, and transparency applied on solids in the DXF/DWG file.
- Solids data at location outside the NX supported bounding box.

DXF/DWG translator- Image translation Caveats

- When you import DXF/DWG model data to NX drawing view, the translator does not support image translation.
- When you import DXF/DWG file that contains image rotated by angle which is not in a multiple of 90, the image is imported with zero degree rotation.

  Note:
  In NX, the images are rotated in steps of 90 degrees only.

- When you import DXF/DWG file with images having other than .jpeg, .tiff, and .png formats to NX, the translator does not support importing of such images.
- Images are not imported if exported as CGM.
- Image translation is not supported if the DXF/DWG file is imported to workpart.

DXF/DWG translator- 3D Workflow caveats

When you export View Breaks using 3D workflow, the translator does not support an export of the following:

- NX Object clipping and view break symbols.
- Geometry clipped inside a view boundary.
- A section line arrow in Break view.

Dimension export using 3D workflow

- When a dimension is exported as a block reference, the foreshortening symbol is not supported.
- 3D workflow does not support the inclusion of before/after appended text in the export of the inspection dimension. It always includes all the appended text in the frame.
- The translator does not support a tolerance separator in the output DXF/DWG file.

Text export using 3D workflow
• When you export text as lines using 3D workflow, the translator ignores the text symbol aspect ratio.

**DXF/DWG translator- Associative dims to polyline and block caveats**

You cannot import dimension as real associative in following scenarios:

• Blocks are imported as custom symbols or as a part and if dimensions are associated with block reference in the DXF/DWG file.

• Dimensions are associated to 2D and 3D polyline.

• Dimensions that have following Object snap points:
  • Tangent
  • Perpendicular
  • Nearest
  • Apparent Intersection
  • Parallel
  • Intersection

• Dimensions are associated to arc segment of the polyline.

**DXF/DWG translator- Support for drafting objects caveats**

You can not export:

• Drawings created in the **Layout** application using the **2D** option.

• Custom symbols used in a PMI table.

• Section views.

**DXF/DWG Support for Hole table**

If the multiple sections of the hole table are created on different drawing sheets, the continuation text will be lost.

**2D Exchange caveats**

• **File→Export→2D Exchange** does not work in NX manager.

• Object attributes with title longer than 50 characters or string value longer than 132 characters are not exported to 2D parts.
2D Exchange – Dimension export caveats

These caveats are applicable for both, when you export a file using the NX Part file option in the 2D Exchange Options dialog box or when you export a file using the 2D option in the AutoCAD DXF/DWG Export Wizard dialog box.

Following dimensions are exported with the Override Dimension Text:

- Feature Parameter Dimensions
- True Length Dimensions
- Dimensions in scaled view and output set to Modeling (applies only when you export a file using the NX Part file option in the 2D Exchange Options dialog box)

Dimensions associated to:

- Drafting Intersection point
- Offset center point
- Section line (in scaled view)
- The dimensions where associated object type changes in the flattened part. For example, circle projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or DWG file.

- Linear and Radial callouts
- Retained dimensions
- Component level dimensions and PMI dimensions
- Inherited ordinate PMI dimensions
- Dual dimension in scaled views and output set to Modeling.
- Dimension with hole and shaft tolerance in scaled views and output set to Modeling.

Dimensions associated with:

- Blanked objects
- 3D and Symmetric centerlines
• Faces
• Two object intersection (applies to ordinate dimension only)
• Target Points
• Dimension created in plane other than view plane.
• PMI Partial Bolt Circle centerline.

2D Exchange translator - Image translation caveats
• 2D Exchange Translator does not translate image, if image is not projected on 2D. This happens when image is in XY plane and trimetric view is exported.
• 2D Exchange Translator supports translation of images only if input is being exported to Part File and not to IGES).

2D Exchange translator - Dimension export caveats
• When Dimension and a Leader are associated with the symmetrical centerline, the translator exports them as a grouped geometry.
• When a radial dimension is associated with a break view geometry, the translator exports it as a group geometry.
• When a perpendicular and angular dimension is associated with a break view section line, translator exports them as a group geometry.

2D Exchange translator - Foreshortening Symbol export caveats
A translator does not support export of foreshortening symbol when dimension is exported as a group in a 2D part.

2D Exchange translator – Leader caveats
A leader with an extension line is converted as a grouped geometry when it is associated with a spline in a 2D part.

2D Exchange translator – Weld symbol caveats
When you export a weld symbol containing arcs, the translator exports it as a grouped geometry.

2D Exchange translator – Support for drafting objects caveats
You can not export:
• Drawings created in the Layout application
• Custom symbols used in a PMI table.
• Section view while exporting Model views.
2D Exchange Support for Hole table

If the multiple sections of the hole table are created on different drawing sheets, the continuation text will be lost.

DXF/DWG and 2D Exchange - PSM body support project caveats

• If you export convergent bodies as polyline mesh, it exports only edges.

• Colors are not honored when you import 3D faces as convergent bodies or JT facets.

• Colors applied to face of convergent body is not honored on export.

• You cannot export model views with convergent bodies with 2D Exchange (or using 2D option on DXF/DWG export dialog box).

STEP translator caveats

• When you export or save NX data to a .stpx file, STEP translator does not export nested external references.

• When you export NX data containing PMI lightweight section views to STEP242:
  • Selective object sectioning is not supported.
  • Section plane display properties are not supported.
  • Section view cross-hatch is not supported.

• When you export NX data to STEP AP242, the translator does not support layer mapping and does not support layer mask.

• When you export NX data to STEP AP203, AP214, or AP242, the translator does not support NX layer categories.

CATIA V5 translator caveats

• The translator exports NX files to CATIAV5 R14 files.

• You cannot import CATIA V5 R7 and earlier version of files.

• You cannot translate standard and user defined attributes.

• Color is supported on a per face basis.
• You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness” values.

• You cannot export NX parts with file name containing international characters.

• The CATIAV5 translator does not keep a log of failed export of password protected data during translation.

• When you import a CATIAV5 file in NX using File→Open method, NX does not automatically save the output file on the disk. You can decide whether to save it or not.

• Before re-importing a CATProduct with different content (potentially due to option choices), it is best to manually delete previous output files in case the IDs in the node or component part filenames shift.

• During import, the translator will look for component files at and below any directories specified through Assembly Search Directories.

• The translator looks for the default settings file in the following sequence:
  1. Settings file specified using the d= option if you launch the translator from command line prompt.
  2. Settings file specified using the NX_CATIAV5_DEF environment variable.
  4. Searches for the settings file in the directory specified by the environment variable UGI_CATIAV5_DIR. If this is not defined on your system, you can set it to %UGI_BASE_DIR%\catiav5 on Windows or $UGI_BASE_DIR/catiav5 on Linux.

**Caveat for all translators**

The password protected parts or assembly components are not exported to other file formats.
12. Mechatronics Concept Designer

Product Notes

PLCOpen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format PLCOpen XML. PLCOpen XML can be imported into STEP 7 5.5 SP 2 Hotfix 4 and above. If you need to update your current STEP 7 installation you can find information about the latest service packs and hotfixes at the following:

English: https://support.industry.siemens.com/cs/products?dtp=Download&mfn=ps&pnid=14342&lc=en-WW

Signal exchange between Mechatronics Concept Designer and external system

Previously, when you exchanged signals between Mechatronics Concept Designer and an external system, the software automatically converted one of the numeric values so the units matched. Due to a design change in MCD, the signal exchange only considers the numeric value, regardless of the assigned units, so you need to manually verify the values.

Runtime Expression units

If you use a Runtime Expression formula without assigning a unit to the result and then you assign the result to a linear parameter, such as linear velocity, the unitless value uses the SI unit of the linear parameter. This is a PR and will be fixed in NX 1876.
13. Automation Designer

Requirements for running Automation Designer NX 1847

- Software platform
  - NX 1872
  - Teamcenter 11.6.0.2 or Teamcenter 12.2
    Automation Designer must be set up as a client/server application with a preconfigured Teamcenter installation
- Active Workspace 4.1
  A valid Active Workspace license
- TIA Portal
  A valid TIA Portal license
  - STEP7 Professional Combo V14 SP1, V15 or V15.1
  - STEP7 Safety Advanced Combo V14 SP1, V15 or V15.1
  - Drive Support: SINAMICS Startdrive V14 SP1, V15 or V15.1
- EPLAN
  A valid EPLAN runtime license and EPLAN runs on the same machine as Automation Designer.
  The standard EPLAN Electric P8 installation provides EPLAN project templates.
  Automation Designer supports only zw9 files.
  - EPLAN Electric P8® v2.7
  - EPLAN Electric P8® v2.8
  - EPLAN — EADN:Application 0193
- eCl@ss
  Using the eCl@ss standard requires a valid license. The Terms of Use for the eCl@ss standard states: "This content contains eCl@ss. The use of the eCl@ss standard requires a license. Please register and order in the DownloadPortal (www.eclassdownload.com)."
  Automation Designer supports eCl@ss ADVANCED Version 8 and newer.
- Operating system requirements
  Automation Designer supports the versions of Windows as supported by NX.
Caveats

Installation

Automation Designer expects a C:\Temp folder to be present. Create it if it is missing.

General

**Number of allowed digits**

If a value provided for a property of Automation Designer violates the number of digits or storage format as it is defined for this property in Teamcenter, system reports a "Too many digits" error.

If updating an Engineering Object to another revision, or while mapping to an external object property, the same issue may occur, but system does not report any error. But as a result, Teamcenter classification do not save this value of the property, and the value is not available in Teamcenter clients, in searches, or reports.

Extend the allowed number of digits or characters in Teamcenter, or, reduce the length of the result property value by truncating or rounding in the calculation.

**Navigations and expressions**

- After updating an Engineering Object to a new revision of its Type, any ancestor navigations filtering for this type do not find the type any longer.

- Canceling entries in the Expression dialog box may result in a crash of the application.
  This happens when you answer with **No** to the question if you want to apply changes that modify an object attribute reference in the Properties dialog box.

- If an Object Attribute Reference (picker) is dependent from a parent navigation, then editing this parent navigation to make it dependent on the picker creates a circular dependency and causes the application to crash.

- If updating a Type to a new revision and adding a picker for a mechanical property value of a linked object during this update, the picker will not pick up the mechanical value.

- If you create a template from an existing project, and a mechanical property is accessed, the template does not correctly extract the mechanical value. Recreate the picker in the template environment.

- If you update a Type to a new revision and you add a picker to the current object navigation by this, the current object navigation step breaks.

- If you create pickers by editing multiple objects in **Bulk Interaction Method** in the Properties dialog box, it may occur that one of the pickers will be invalid. Edit object by object, or use the **Traditional Interaction Method**.
Snapshot

The functionality to inspect a snapshot is limited and experimental. NX inter-part relations might resolve to a newer part than the one which is member of the snapshot.

You can only use the Inspection functionality, when the environment variable is set: `AD_ENABLE_INSPECT_SNAPSHOT=1`.

You can only inspect a snapshot while the same project is closed, and no other snapshot of this project is inspected at the same time.

Value Set

If you add an Engineering Object with a Product Selection to a template, system creates a value set that changes this Product Selection. If you apply this value set to the usage of the template that was created already before, the template and the value set are extended by the Engineering Object and this results in an error.

Performance

- Queries using properties of a product in a clause execute slowly.

- If you save projects that are created with a previous version to NX1872, the saving action takes long. To improve the performance, change any of the following settings and save the project:
  - Project properties
  - Document structure
  - Annotation settings
  - Naming Rules
  - EPLAN project settings

- If you assign a collection of Engineering Objects to a PLC, it takes long.

- Printing schematic pages takes long.

- Selecting a product for a device takes long if the product adds many ports to the device.

Collaboration

Object Mapping

- If multiple Automation Designer projects use the same mechanical design, you can only map one Engineering Object to the same mechanical component at a time. In the other Automation Designer projects, the object mapping fields are disabled for this component.
  
  To map to a mechanical component, you must unmap the component before in the project where the mapping exists already.
• You can only map a source object to an Engineering Object if the Engineering Object is loaded. If the Engineering Object is not loaded, a new Engineering Object can be mapped and inserted based on an existing type mapping. This results in an inconsistent display of the data of the mapped object and the mapping fields. To avoid this, load the mapped Engineering Objects by expanding the navigators before creating new mappings based on type.

• Avoid creating multiple subsets to the same Collaborative Design. Unloading an external object might load other external objects instead.

**Data Exchange**
If a product with sub-components is transferred from one Teamcenter site to another one, the sub-components library items need to be transferred explicitly. For more information, see *Data Exchange between Teamcenter Sites* in the Automation Designer Online help.

**Electrical**

**Product Selection**
If you replace a cable with another one, this reverts to system created sequence of cores. Any manual order is lost.

**Schematics**
Connections sometimes do not show complete sources or targets if a target is part of a terminal strip or plug.

Cables show every target on terminal strip or plug instead of one for each terminal strip or plug.

**Symbol Editing**
If you combine custom symbols, you must apply Smash Symbol On Placement while creating or defining geometry for a custom symbol. Otherwise the symbol graphic is not displayed when the symbol is used on a page.

**Query**
• To list the complete target information if a target is part of a terminal strip or plug, the Object name property must be added to the query result to show the complete terminal name information.

• Sorting the query result list by the value of a property does not work.

**Reports**
• Terminal Diagrams show only used terminal levels. Unused terminal levels are not reported.

• Cable Diagrams show only used cable cores. Unused cable cores are not reported. Additional cable shields are not reported.

• All result formatting uses the formatting of the first cell in the result table which is the top left column of the first row.

**EPLAN Exchange**
If you send a window macro to EPLAN for editing that did not contain a placeholder object before, and you add the placeholder object in this session, assure that the placeholder object is assigned to the macro box. EPLAN Help describes how to do this.
Software Generation

TIA Portal exchange

If you delete sub Technology Objects of a Technology Object in Automation Designer, and this Technology Object already exists in TIA Portal and has still the sub Technology Objects, the transfer of the modified Technology Object from Automation Designer to TIA Portal is skipped without a message.
14. Programming Tools

Open C

New Open C routines

The following routines are new for this release:

UF_ASSEM_add_snapshot_motion_to_sequence
UF_CLONE_ask_assign_default_project
UF_CLONE_ask_retain_original_ownership
UF_CLONE_set_assign_default_project
UF_CLONE_set_retain_original_ownership
UF_KF_ask_list_item_value
UF_KF_ask_number_with_measure
UF_KF_ask_number_with_unit
UF_KF_convert_to_degree_base
UF_KF_convert_to_radian_base
UF_KF_make_number_with_measure
UF_KF_make_number_with_unit
Obsoleted Open C routines

The following routines are now obsolete and will be deleted in the next major release of NX:

- UF_DRF_initialize_custom_symbol_data
- UF_DRF_create_custom_symbol_instance
- UF_ROUTE_set_characteristics
- UF_ROUTE_ask_characteristics
- UF_ROUTE_delete_characteristics
- UF_ROUTE_load_part_by_charx
- UF_ROUTE_set_charx_env
- UF_ROUTE_update_charx_env
- UF_ROUTE_ask_charx_env
- UF_ROUTE_match_charx_in_plib
- UF_ROUTE_free_match_results
- UF_ROUTE_free_charx_array
- UF_ROUTE_find_title_in_charx
- UF_ROUTE_find_terminal_charx
- UF_ROUTE_characteristic_match_plugin_s
- UF_ROUTE_split_descriptors_plugin_s
- UF_ROUTE_cb_fab_data_s

#define UF_ROUTE_CHARX_TYPE_UNKNOWN     UF_EPLIB_CHARX_TYPE_UNKNOWN
#define UF_ROUTE_CHARX_TYPE_INT         UF_EPLIB_CHARX_TYPE_INT
#define UF_ROUTE_CHARX_TYPE_REAL        UF_EPLIB_CHARX_TYPE_REAL
#define UF_ROUTE_CHARX_TYPE_STR         UF_EPLIB_CHARX_TYPE_STR
#define UF_ROUTE_CHARX_TYPE_ANY         UF_EPLIB_CHARX_TYPE_ANY
#define UF_ROUTE_CHARX_TYPE_REF         UF_EPLIB_CHARX_TYPE_REF
#define UF_ROUTE_CHARX_TYPE_ANY_REF     UF_EPLIB_CHARX_TYPE_ANY_REF
#define UF_ROUTE_CHARX_TYPE_INT_EXPR    UF_EPLIB_CHARX_TYPE_INT_EXPR
#define UF_ROUTE_CHARX_TYPE_REAL_EXPR   UF_EPLIB_CHARX_TYPE_REAL_EXPR
#define UF_ROUTE_CHARX_TYPE_STR_EXPR    UF_EPLIB_CHARX_TYPE_STR_EXPR
#define UF_ROUTE_CHARX_EXPR_unknown             ERROR_ROUTE_base + 165
#define UF_ROUTE_CHARX_EXPR_err_num_eq_eq       ERROR_ROUTE_base + 166
#define UF_ROUTE_CHARX_EXPR_err_num_eq_none     ERROR_ROUTE_base + 168
#define UF_ROUTE_CHARX_EXPR_err_num_eq_str      ERROR_ROUTE_base + 169
#define UF_ROUTE_CHARX_EXPR_err_num_num_eq      ERROR_ROUTE_base + 170
#define UF_ROUTE_CHARX_EXPR_err_num_num_rel     ERROR_ROUTE_base + 171
#define UF_ROUTE_CHARX_EXPR_err_num_num_num     ERROR_ROUTE_base + 172
#define UF_ROUTE_CHARX_EXPR_err_num_num_str     ERROR_ROUTE_base + 173
#define UF_ROUTE_CHARX_EXPR_err_num_range_eq    ERROR_ROUTE_base + 174
#define UF_ROUTE_CHARX_EXPR_err_num_range_rel   ERROR_ROUTE_base + 175
#define UF_ROUTE_CHARX_EXPR_err_num_range_range ERROR_ROUTE_base + 176
#define UF_ROUTE_CHARX_EXPR_err_num_range_str   ERROR_ROUTE_base + 177
#define UF_ROUTE_CHARX_EXPR_err_num_rel_eq      ERROR_ROUTE_base + 178
#define UF_ROUTE_CHARX_EXPR_err_num_rel_rel     ERROR_ROUTE_base + 179
#define UF_ROUTE_CHARX_EXPR_err_num_rel_none    ERROR_ROUTE_base + 180
#define UF_ROUTE_CHARX_EXPR_err_num_rel_range   ERROR_ROUTE_base + 181
#define UF_ROUTE_CHARX_EXPR_err_num_rel_str     ERROR_ROUTE_base + 182
#define UF_ROUTE_CHARX_EXPR_err_num_none        ERROR_ROUTE_base + 183
#define UF_ROUTE_CHARX_EXPR_err_num_str         ERROR_ROUTE_base + 184
#define UF_ROUTE_CHARX_EXPR_err_str_eq_eq       ERROR_ROUTE_base + 185
#define UF_ROUTE_CHARX_EXPR_err_str_eq_rel      ERROR_ROUTE_base + 186
#define UF_ROUTE_CHARX_EXPR_err_str_eq_none     ERROR_ROUTE_base + 187
#define UF_ROUTE_CHARX_EXPR_err_str_quote_eq    ERROR_ROUTE_base + 188
#define UF_ROUTE_CHARX_EXPR_err_str_quote_rel   ERROR_ROUTE_base + 189
#define UF_ROUTE_CHARX_EXPR_err_str_quote_quote ERROR_ROUTE_base + 190
#define UF_ROUTE_CHARX_EXPR_err_str_quote_str   ERROR_ROUTE_base + 191
#define UF_ROUTE_CHARX_EXPR_err_str_str_eq      ERROR_ROUTE_base + 192
#define UF_ROUTE_CHARX_EXPR_err_str_str_rel     ERROR_ROUTE_base + 193
#define UF_ROUTE_CHARX_EXPR_err_str_str_quote   ERROR_ROUTE_base + 194
#define UF_ROUTE_CHARX_EXPR_err_str_str_str     ERROR_ROUTE_base + 195
#define UF_ROUTE_CHARX_EXPR_err_str_none        ERROR_ROUTE_base + 196
#define UF_ROUTE_CHARX_EXPR_err_str_rel_rel     ERROR_ROUTE_base + 197
Deleted Open C routines

The following routines are deleted for this release:

- UF_ROUTE_RUN_ask_from_items
- UF_ROUTE_RUN_ask_member_items
- UF_ROUTE_RUN_ask_run_id_and_type
- UF_ROUTE_RUN_ask_runs_in_part
- UF_ROUTE_RUN_ask_to_items
- UF_ROUTE_RUN_edit_run
- UF_ROUTE_RUN_set_run_id
- UF_ROUTE_RUN_set_run_type

NX Open

NX Open differences between releases

The NX Open differences between releases and deprecated items replacements are now published in the Documentation Center.

In the Documentation Center, for your release, click What's Changed in NX Configuration and NX Open. From there, click NXOpen APIs to open the NXOpen APIs What's Changed Reports webpage.

You can select the Changes That May Require Code Changes tab to view the changes that have occurred for the release and any that might require changes to your existing code. The What's New tab provides new items for the release.

You can compare your release to another one to see the amount of change that has occurred between the two releases. In the Comparing NX <your release> and: listing, select the release you want for comparison, and click Compare. You can get comparisons for up to two years of releases.
Release upgrades

A primary goal of NX Open is to maintain your automation investments. This is done by adopting policies which minimize the amount of required code changes by you to migrate your applications to new releases of NX. The following contains a description of these policies and how they impact your ability to support the users of your applications, and the steps you should take to successfully move your application to new releases of NX.

NX Open API change policy

NX maintains the following three primary policies to protect your investments:

• **API stability**
  Stability ensures that the API that has been released will continue to work. This means that the API is still present in future releases and the behavior of the API doesn't change. API changes should be designed to minimize any changes to your source code. For example, if the capabilities of a method are expanded which requires new parameters, then NX may maintain and optionally deprecate the original method and add a new method that includes the new capabilities. By doing this, existing applications do not require code changes unless they want to take advantage of the new capabilities.

• **Binary compatibility**
  Compatibility means that applications that are built against a specified release continue to work with subsequent releases. This requires not only that API stability is maintained but also is binary compatible. For example, re-ordering the values of enum members so that API stability is maintained. In this case, the values have changed so existing automation programs will be using the wrong values. In other cases, deleting a method or modifying the inheritance hierarchy of a class will likely cause run-time errors for existing programs.
  The other aspect of binary compatibility is the compiler. When the compiler NX uses changes, this may break binary compatibility of automation programs. While some language bindings are more tolerant of being backwards compatible, such as Java, others are not as tolerant, such as C++.
  NX libraries will be forward compatible for all releases in a release family. If you compile and link your application with the libraries shipped with a functional release of NX, such as NX 1847, then your application should continue to run with all future monthly releases in that release family (NX 1847).
  This compatibility means you do not need to recompile, relink, and reship your applications to customers running various monthly releases of NX. Note that NX is not backwards compatible, which means you can't compile and link an application in NX 1847 and expect it to work in NX 12.
  NX will only change the compiler used (breaking binary compatibility) in a functional release and will not change it more than once a year. During the functional release, the compiler may change and APIs may be retired per the deprecation policy for deletion.

• **Deprecation policy**
  If an API change requires you to make source code changes, you are given notice one year in advance, if possible. For example, if a method is going to be replaced by a new method, the original method is marked as deprecated in NX 1847, which is the release family. The original method is maintained through the current release family and through the next release family also, after which the API may be retired and removed.
  The what's changed reports in the Documentation Center and, if possible, compile time warnings are used to warn you of changes made in the current release and changes coming in the next release.
The deprecated items topic in the Documentation Center provides a list of the deprecated methods and their replacement methods. For more information about the Documentation Center, see NX Open Differences between releases.

Note:

NX development makes every effort to follow the above policies. However, there may be instances when the policies must be violated due to the type of changes required. When this type of change is made, it is published on the Changes That May Require Code Changes tab in the Documentation Center. This includes information on the change that happened and suggests changes that could be made to the code.

NX maintains and publishes stability metrics that show that for at least the last 10 years the stability of the NX Open APIs is above 96% for any given release, while the average is above 99%.

Exploring changes to the NX Open API between releases

NX Open changes are published in the Documentation Center. In the NXOpen APIs section for your release, you can view API changes in the NXOpen APIs What's Changed Reports.

By default, this webpage contains the reports of the current release and the last functional release. In addition, you can select a release to compare with your release to get a comparison between the two releases. You can get comparisons for up to two years of releases.

Each page presented provides a point-to-point comparison of the APIs. The What's New tab on the page presents the new API items added between the two selected releases. The Changes That May Require Code Changes tab provides information that shows the changes that violate API stability and (or) binary compatibility, in accordance with the rules specified in the above policies.

For example, removing API items violates our API stability and binary compatibility policy unless the compiler changes. For each entry, we provide remediation suggestions, if needed, and possibly the reason for the change. An example of a change for which the only remedy is to recompile, is if a class has a new base class inserted into its hierarchy. In this case, you don't need to change your code, but you do have to recompile your automation code that uses the API. This is contrasted by changes to a method signature to add an additional parameter. In this case, there will be a description of what the new parameter's purpose is and how to use it.

Also, the Changes That May Require Code Changes tab lists all of the deprecated APIs, their replacement APIs, and the earliest that each API could be retired. APIs that are retired are listed on the tab, along with when the API was removed and their replacement.

Open C API changes are listed in the NX release notes, in the New Open C routines, Obsoleted Open C routines, and Deleted Open C routines topics.

Function declarations that are newly retired (obsolete/deprecated) are moved to the uf_retiring.h file, which contains a complete list of Open C functions that could be deleted in the next NX release.
Release upgrade process for a functional release

For each functional release of NX, you should perform the following steps to migrate your application to the release:

1. Review the **Changes That May Require Code Changes** tab for the release you are going from and upgrading to. This helps you to understand what changes are being made in the release and what changes are planned for the next release.

2. For any methods or properties that have been deleted and for those which you have not already replaced in your code, implement the replacement code.

3. Recompile your entire source base using the current compile time files and settings for the given release.

4. For any methods or properties that produce deprecation warnings, decide if you are going to replace this code now or in the next release. Implement the replacement code for any deprecated methods you want to replace now and recompile.

5. Link your application with the appropriate NX Open libraries.

6. Perform a full suite of application testing in a stable NX environment.

7. Distribute your applications to your user base.

Release upgrade process for a monthly release

For each monthly release of NX, you should perform the following steps to migrate your application to the release:

1. Review any changes for the monthly release in the **Documentation Center**.

2. Any API changes that may require rework or a recompile of your code will only be made if absolutely necessary. In this case, you will have to rework or recompile the affected applications, then test and redistribute. These changes are provided in the **Documentation Center**.
Product Notes

Compilers and environments to use for NX Open programs

The following table specifies the compiler (or installation for Python) to use for the applicable platform. These are the only ones certified for use with NX Open:

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>C/C++</td>
<td>Visual Studio 2017 Build 19.10.25017</td>
<td>gcc 4.8.2</td>
</tr>
<tr>
<td>.NET</td>
<td>.NET 4.6.2 Framework</td>
<td>N/A</td>
</tr>
<tr>
<td>Java (64–bit)</td>
<td>JDK 1.8.0_45</td>
<td>JDK 1.8.0_45</td>
</tr>
<tr>
<td>Python (64–bit)</td>
<td>Python 3.7.1</td>
<td>Python 3.7.1</td>
</tr>
</tbody>
</table>

Running Java and .NET programs

To run programs created in NX Open that require Java or .NET, the following is required:

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>.NET</td>
<td>.NET 4.6.2 Framework</td>
<td>N/A</td>
</tr>
<tr>
<td>Java (64–bit)</td>
<td>JRE 8</td>
<td>JRE 8</td>
</tr>
</tbody>
</table>

Note:

Some standard NX applications, such as translators, require installation of the JRE. For additional information, see Considerations and caveats.

Internet browsers

If you do not see the latest documentation for the following programming tools, it may be a cache issue. Try clearing your cache, or using a different browser.

- *Open C Reference Guide*
- *NX Open C++ Reference Guide*
- *Open for Java*
- *NX Open Python*
Open for .NET

In the Open C Reference Guide, if links to the example .c files do not work in IE, the .c file may not have an associated program to open it. Follow the instructions for your operating system to associate the .c file to a program, such as Notepad.

Signing applications

An executable for an application created with NX Open must be signed before it can be executed by anybody who does not have a NX Open Author license. This typically includes the primary users of the executable, such as mechanical designers at your site. The signing process is performed with the NX Open signing utility before the application is distributed to the user base.

Starting in NX 1872, for C++ executables, you can sign the executable using the NX Open signing utility and also have the executable digitally signed. Previously, you could not do both as the NX Open signing process was not compatible with digital signing.

Adding digital signing provides an additional level of security and protection especially if the application is going to other sites. Digital signing can be done by a Microsoft approved third-party certificate authority (CA), or you can perform your own digital signing.

Application programs signed with the NX Open signing utility in NX 1847 will continue to work in NX 1872. You only need to re-sign the application if you want to also include digital signing.

The combination of NX Open signing and digital signing is only applicable for C++ executables.
About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.

© 2019 Siemens Product Lifecycle Management Software Inc. Siemens, the Siemens logo and SIMATIC IT are registered trademarks of Siemens AG. Camstar, D-Cubed, Femap, Fibersim, Geolus, l-deas, JT, NX, Omneo, Parasolid, Solid Edge, Syncrofit, Teamcenter and Tecnomatix are trademarks or registered trademarks of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks or service marks belong to their respective holders.